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This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions: 

(1) This device may not cause harmful interference, and 
(2) this device must accept any interference received, including interference that may cause undesired 
operation. 

 
This product complies with the essential requirements and other relevant provisions of Directive 2014/53/EU. The declaration of conformity may be consulted at 

https://hemispheregnss.com/About-Us/Quality-Commitment.  

 

Copyright Notice 
Copyright Hemisphere GNSS, Inc. (2017). All rights reserved. 

No part of this manual may be reproduced, transmitted, transcribed, stored in a retrieval system or translated into any language or 
computer language, in any form or by any means, electronic, mechanical, magnetic, optical, chemical, manual or otherwise, 
without the prior written permission of Hemisphere GNSS. 

 
 

Trademarks 
Hemisphere GNSS®, the Hemisphere GNSS logo, TRACERTM, Crescent®, EclipseTM, e-Dif®, L-DifTM, miniEclipseTM, 
PocketMax PCTM, PocketMaxTM, PocketMaxTM, S320TM, SBX-4TM, VectorTM, XF1TM,and XF2TM are proprietary trademarks of 
Hemisphere GNSS, Inc. Other trademarks are the properties of their respective owners. 

 
 

Patents 
Hemisphere GNSS products may be covered by one or more of the following patents: 

U.S. Patents     Australia Patents 

6111549 6876920 7400956 8000381 8214111 2002244539 

6397147 7142956 7429952 8018376 8217833 2002325645 
6469663 7162348 7437230 8085196 8265826 2004320401 
6501346 7277792 7460942 8102325 8271194  

6539303 7292185 7689354 8138970 8307535  

6549091 7292186 7808428 8140223 8311696  

6711501 7373231 7835832 8174437 8334804  

6744404 7388539 7885745 8184050 RE41358  

6865465 7400294 7948769 8190337   

Other U.S. and foreign patents pending. 

 
 

Notice to Customers 
Contact your local dealer for technical assistance. To find the authorized dealer near you:  

Hemisphere GNSS, Inc 
8515 East Anderson Drive  
Scottsdale, AZ 85255  USA  
Phone: (480) 348-6380 
Fax: (480) 270-5070 
precision@hgnss.com  
 www.hgnss.com 

 
 

Technical Support 
If you need to contact Hemisphere GNSS Technical Support:  
Hemisphere GNSS, Inc. 
8515 East Anderson Drive 
Scottsdale, AZ 85255 USA 
Phone: (480) 348-6380 
Fax: (480) 270-5070 
techsupport@hgnss.com 

 
 

Documentation Feedback 
Hemisphere GNSS is committed to the quality and continuous improvement of our products and services. We urge you to 
provide Hemisphere GNSS with any feedback regarding this guide by writing to the following email address:    
techsupport@hgnss.com. 
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Terms and Definitions 
 
The following table lists the terms and definitions used in this document 
 
 

Term Definition 

1PPS 1 pulse-per-second is a pulse that is output by the receiver 
precisely once a second and is used for hardware 
synchronization. 

Activation Activation refers to a feature added through a one-time 
purchase. For features that require recurring fees, see 
Subscription. 

aRTK aRTK is a Hemisphere GNSS exclusive service that uses 
Atlas to extrapolate the last RTK correction during an RTK 
outage so that the length of time an RTK position can be used 
after an RTK outage is extended. 

Atlas Atlas is a subscription based service provided by Hemisphere 
that enables the VS330 to achieve sub-decimeter accuracy 
after a twenty-minute convergence period without the need for 
a base station or datalink. 

Base Station The Base Station is a receiver placed over a familiar point. 
The base station then provides real-time observations and 
sends these to nearby RTK rovers via UHF radio or the 
internet. The RTK rover (such as a VS330) is then able to use 
information contained in these messages to calculate a 
differential correction and improve accuracy. 

BeiDou BeiDou is a Chinese satellite based navigation system. Global 
coverage is expected by 2020. 

Datalink Datalink is the device used to send RTK or DGNSS 
corrections from a base station to one of more rovers. 
Common datalinks are UHF radio or Ntrip (see Ntrip). 

DGPS/DGNSS Differential GPS/GNSS refers to a receiver using Differential 
Corrections. 

Differential Corrections Differential Corrections improve the precision of a GNSS 
rover. Two GNSS receivers placed in a nearby area will have 
similar error. A base station is placed over a known point. 
Since the actual position of the base station is known, error 
can be calculated and corrections can then be applied to 
nearby rovers. This differs from RTK (see RTK). 

Dual-Frequency Dual-Frequency use both L1 and L2 signals from GPS 
satellites, G1 and G2 signals from GLONASS satellites, and 
B1 and B2 signals from BeiDou satellites. Single frequency 
receivers will only use L1, G1, and B1. 

EGNOS  European Geostationary Navigation Overlay Service 
(EGNOS) is a satellite-based augmentation system (SBAS) 
that provides free differential corrections over satellite in parts 
of Europe. 
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Terms and Definitions (continued) 
 

Elevation Mask Elevation Mask is the minimum angle between a satellite and 
the horizon for the receiver to use that satellite in the solution. 
Satellites near the horizon often provide noisy signals and 
should be avoided. 

Firmware Firmware is the software loaded into the receiver that controls 
the functionality of the receiver and runs the GNSS engine. 

  
GAGAN GPS Aided Geo Augmented Navigation (GAGAN) is a satellite 

based augmentation system (SBAS) that provides free 
differential corrections over satellite in India. 

GLONASS Global Orbiting Navigation Satellite System (GLONASS) is a 
Global Navigation Satellite System (GLONASS) deployed, 
and maintained, by Russia. It is comparable to the United 
States’ GPS system. 

GNSS Global Navigation Satellite System (GNSS) is a system that 
provides autonomous 3D position (latitude, longitude, and 
altitude) along with very accurate timing globally by using 
satellites. Current GNSS providers are: GPS, GLONASS and 
Galileo. BeiDou is expected to have global coverage by 2020. 

GPS Global Positioning System (GPS) is a global navigation 
satellite system implemented by the United States. 

Heading Heading is the angle between true north and the vector 
calculated from the primary to secondary antenna. 

Heading Bias Heading Bias is an offset applied to the heading value the 
receiver calculates. This can be used if the antennas are 
installed in such a way that the vector created from the 
primary to secondary antenna does not match up with the 
centerline of the vessel. 

Mountpoint Mountpoints are the specified data streams in Ntrip. Multiple 
base stations may send data to an Ntrip caster. Each base 
station has a unique Mountpoint. Therefore, an Ntrip client 
must specify from which mountpoint the Ntrip client will 
receive data. 

Multipath Multipath occurs when the GNSS signal reaches the antenna 
by two or more paths. This causes incorrect psuedorange 
measurements and leads to less precise GNSS solutions. 

NMEA National Marine Electronics Association (NMEA) is a marine 
electronics organization that sets standards for 
communication between marine electronics.  
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Terms and Definitions (continued) 
 

Ntrip Networked Transport of RTCM via Internet Protocol (Ntrip) is 
a protocol for streaming GNSS data over the internet. Ntrip is 
most often used to stream RTK or DGNSS corrections over 
the internet. 

Ntrip Caster Ntrip casters receive data from one or more Ntrip servers and 
the data is available to one or more Ntrip clients. Each data 
source (Ntrip server) must send the data to a specified Ntrip 
mountpoint, and the Ntrip client must specify which 
mountpoint to receive data from. This allows multiple base 
stations on the same network. 

Ntrip Client Ntrip clients receive data from the Ntrip caster and provide 
this data (often over GSM or serial) to the GNSS receiver. 

Ntrip Server The Ntrip server sends data from the Ntrip source (base 
station) to the Ntrip caster. 

  
ROX ROX is a Hemisphere GNSS propriety RTK message format 

that can be used as an alternative to RTCM3 when both the 
base and rover are Hemisphere branded. 

RTCM Radio Technical Commission for Maritime Services (RTCM) is 
a standard used to define RTK message formats so that 
receivers from any manufacturer can be used together. 

RTK Real-Time-Kinematic (RTK) is a real-time differential GPS 
method that provides better accuracy than differential 
corrections. 

SBAS Satellite Based Augmentation System (SBAS) is a system that 
provides differential corrections over satellite throughout a 
wide area or region. 

Signal-to-Noise Ratio Signal-to-Noise Ratio (SNR) is the ratio of the message 
content of the signal against the noise of the signal. 

Subscription A subscription is a feature that is enabled for a limited time. 
Once the end-date of the subscription has been reached, the 
feature will turn off until the subscription is renewed. 

WAAS Wide Area Augmentation System (WAAS) is a satellite-based 
augmentation system (SBAS) that provides free differential 
corrections over satellite in parts of North America. 

 
 
 

  



VS330 User Guide  Chapter 1 - Introduction Page 1 of 47 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Chapter 1: Introduction 
 

Product Overview 

Key Features 

What’s Included in your Kit 

Firmware Upgrades



VS330 User Guide  Chapter 1 - Introduction Page 2 of 47 

 

 

 

 

 

Introduction 
 
This User Guide provides information to help you quickly set up your Vector™ VS330™ GNSS 
compass. 

 

Product Overview 
 
Based on Eclipse™ GNSS technology, the VS330 is designed for 
marine and land applications that require precise heading and RTK 
position performance. Featuring a Hemisphere GNSS Eclipse Vector-
based receiver and two separate antennas, VS330 achieves heading 
accuracy ranging from 0.01º to 0.17º RMS (depending on the antenna 
separation) and offers robust positioning performance. 

 
The standard model VS330 tracks single frequency GPS, GLONASS, and BeiDou . The 
VS330 can be upgraded via activations and/or subscriptions to support multi-frequency 
GPS, GLONASS and BeiDou as well as Athena RTK and Atlas L-band. VS330 supports 
raw data logging to a removable USB flash drive for post processing. 
 
Athena RTK 
 
Athena RTK (Real Time Kinematic) technology is available on Eclipse‐based GNSS receivers. 
This is Hemisphere's most advanced RTK processing software, and can be added to the VS330 
as an activation.  
 
Athena RTK has the following benefits: 

• Improved Initialization time ‐‐‐‐ Performing initializations in less than 15 
seconds at better than 99.9% of the time 

• Robustness in difficult operating environments ‐‐‐‐ Extremely high productivity 
under the most aggressive of geographic and landscape oriented environments 

• Performance on long baselines ‐‐‐‐ Industry‐leading position stability for long 
baseline applications 

 
  

Note: Throughout the rest of this user guide the Vector™ VS330™ GNSS Compass is 
referred to simply as the VS330. 
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Atlas L-band 
 
Atlas L-band is Hemisphere's industry leading correction service, which can be added to the 
VS330 as a subscription. Atlas L-band has the following benefits: 

• Positioning accuracy - Competitive positioning accuracies down to 4 cm RMS in 
certain applications 

• Positioning sustainability - Cutting edge position quality maintenance in the absence 
of correction signals, using Hemisphere’s patented technology 

• Scalable service levels - Capable of providing virtually any accuracy, precision and 
repeatability level in the 4 to 100 cm range 

• Convergence time - Industry-leading convergence times of 10-40 minutes 
 

For more information about Athena RTK, see: http://hemispheregnss.com/Technology 
For more information about Atlas L-band, see: http://hemispheregnss.com/Atlas 

 

Key Features 
 
Key features of the VS330 include: 

• High precision RTK positioning  
(Horizontal RMS 10mm + 1ppm, Vertical RMS 20mm + 2ppm) 

• DGNSS corrections from all SBAS constellations and over beacon 
• Position accuracies of 4cm horizontal RMS/8cm vertical RMS without the need of a base 

station by using Atlas L-band* 
*Requires the purchase of a subscription 

• Heave of 30 cm RMS (DGNSS), 10 cm (RTK) 
• Heading accuracy ranging from 0.01º to 0.17º RMS (depending on the antenna 

separation) without the need of RTK or DGNSS 
• Pitch and roll < 1° RMS 
• Simple menu operations 
• 1 PPS output 
• Event marker input 
• 2 full-duplex RS232 and 1 half-duplex RS422 serial ports for RTK input/output, NMEA 

0183 output, and serial configuration 
• 1 USB port for logging raw GNSS data for post processing, logging diagnostic data, or 

configuring the receiver 
• 20 Hz output (with activation) 
• Accurate heading up to 3 minutes during GNSS outages 
• Integrated gyro and tilt sensors deliver fast startup times and provide heading updates 

during temporary loss of GNSS 
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What’s Included in Your Kit 
 
Your VS330 kit (Figure 1-1) includes the following parts: 

• VS330 receiver and related mounting hardware 
• Power and data cables 

 
Note: The standard VS330 kit does not include antennas, antenna mounting hardware, 
and antenna cables since receiver options vary. 

 

 

 
 

Figure 1-1: VS330 System Parts diagram 
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Table 1-1 provides the description and part number of each part in your kit. 
 
Review the parts shipped with your kit. If any parts are damaged, contact your freight carrier. If 
any parts are missing, contact your dealer. 

 

Table 1-1: Parts List 
 

Item Part Name Qty Part Number 

A VS330 receiver 1 803-3028-0 

B Receiver mounting kit 
(two brackets and related hardware) 

1 710-0056-000# 

C Power cable, circular 1 054-0146-000# 

D Data cable, DB-9 female to DB-9 male, 3 m 1 050-0011-022# 

The following are available for purchase separately from the standard VS330 kit. 

E Antenna (quantity of each based on your purchased 
configuration) 

A42 
A43 
A52 

A45 

  
 

804-3045-000# 
804-3046-000# 
804-3038-000# 
750-9006-0- 

F Antenna mounting kit (quantity of each based on your 
purchased configuration) 

A42 
A43 
A52 

Note: Your kit may not include a mag mount. 

  
 

710-0110-000# 
710-0111-000# 
710-0097-000# 

G Antenna cable, TNC male to TNC male, 5 m 2 052-0005-000# 
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Firmware Upgrades 
 
Firmware Upgrades 
 
Periodically, Hemisphere GNSS releases firmware upgrades to improve performance, fix bugs, 
or add new features to a product. To update the firmware on the VS330, download the latest 
version of Hemisphere GNSS RightArm from the following link: 
https://hemispheregnss.com/Resources-Support/Software 
 
Connect the VS330 to a computer over serial. Firmware can be loaded over either serial port. 
Set the baud rate of the serial port you are using to 19200. Launch RightArm. Click on the 
Connect button or go to Receiver -> Connect. 
 

 
 
Choose the COM port connected to the VS330, and click OK. 
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Note: The baud rate of the serial port should be set to 19200 bps. Select “Allow Auto Baud” to 
enable the receiver to change the baud rate during the firmware upgrade for a faster update. 
 
Click on the Programming button. 
 

 
 
Select a ‘Program Type.’  
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The VS330 has two firmware applications, allowing two different versions of GNSS firmware. 
Hemisphere GNSS suggests loading the new firmware onto both applications.  
 
After the firmware update is completed, check the current GNSS firmware. 
 
If the current firmware is not the same as the newly loaded firmware, the VS330 could be using 
the other application. You can switch applications by sending the following command:  
 
$JAPP,OTHER. 
 
Choose the Application, and press Select File to select the firmware file. 
 

 
 
Choose the firmware, and click Erase and Program. 
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Note: Before clicking the Erase and Program button, the Activate Loader check box in the 
Programming View window is selected. After pressing the Erase and Program button, the check 
box should be cleared and the Status field should show that the receiver is in loader mode and 
ready to receive the new firmware file. If the Activate Loader check box remains selected, power 
the receiver off and on. When the receiver powers back on, the Activate Loader box should be 
de-selected. 
  
 

 Do not to interrupt the power supply to the receiver, and do not interrupt the 
communication link between the PC and the receiver until programming is complete. 
Failure to do so may cause the receiver to become inoperable and will require it to be 
returned to the factory for repair. 
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After completing the firmware update, Hemisphere GNSS suggests repeating this process for 
the other application. 
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Understanding the VS330 
 
The GNSS receiver begins tracking satellites when it powers up and an antenna has connected 
to the antenna port on the receiver. Position and heading accuracy vary depending on location 
and environment. Position performance can be improved with RTK or DGNSS. 
 
The following sections provide the steps to configure your VS330 to use Atlas, Beacon, SBAS, 
or RTK. 
 

 

Differential or RTK Operation 
 
The purpose of differential GNSS (DGNSS) and RTK is to remove the effects of atmospheric 
errors, timing errors, and satellite orbit errors, while enhancing system integrity. 
 
Autonomous positioning capabilities of the VS330 will result in positioning accuracies of 2.5 m 
95% of the time. To improve positioning quality the VS330 can receive DGNSS corrections over 
SBAS or Beacon, can receive L-band corrections with Hemisphere GNSS’ Atlas L-band 
technology, or receive RTK corrections over serial. 
 
For more information on the differential services and the associated commands refer to the 
Hemisphere GNSS Technical Reference . 
 

SBAS Tracking 
 
The VS330 automatically scans and tracks SBAS signals without the need to tune the receiver. 
The VS330 features two-channel tracking that provides an enhanced ability to maintain a lock on 
an SBAS satellite when more than one satellite is in view. This redundant tracking approach 
results in more consistent tracking of an SBAS signal in areas where signal blockage of a 
satellite is possible.  
 
SBAS comes with the VS330 as a standard feature and does not require an activation or 
subscription code. 
 
SBAS can be configured through the menu display of your VS330. For further details, please 
see Figure C-3. 
 
Beacon Operation 
 
Many marine authorities, such as coast guards, have installed networks of radio beacons that 
broadcast DGNSS corrections to users of this system. With the increasing utility of these 
networks for terrestrial applications, there is an increasing trend toward densification of these 
networks inland. The dual channel beacon receiver in the VS330 can operate in manual or 
automatic tuning mode, or, using database mode, will select the closest station in compliance 
with IEC 61108-4 standards. 
 
To configure the VS330 for beacon, connect the beacon capable antenna to the secondary 
antenna port. Then use Figure C-5 to configure the VS330 for beacon use. 
 
 

  

Note: Differential source and RTK status have no impact on heading, pitch, or roll. They 
only have an impact on positioning and heave. 
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Athena RTK 
 
Athena RTK requires the use of two separate receivers: a stationary base station (primary 
receiver) that broadcasts corrections over a wireless link to the rover (secondary receiver). 
 
The VS330 can use RTK brought in through either serial port. The receiver will use any RTK 
message coming in over a serial port if the RTK message type is included in the list of available 
differential sources. Refer to Figure C-4 for including a differential type ( ROX, RTCM3, or CMR). 
If you do not know which RTK message type is being sent by the base station, you can include 
RTCM3, ROX, and CMR. Including extra differential sources will not affect the receiver if those 
differential sources are not being received. 
 
Once the differential source has been set, configure the baud rate of the serial port receiving the 
RTK corrections. Ensure that the serial port configuration of the external device (such as radio or 
modem) is 8 bits/byte, 1 stop bit, no parity and no flow control. 
 
Connect the external device to the serial port of the VS330. Some cables may require the use of 
a gender changer and/or null modem adapter. 
 
Atlas L-band 
 
Atlas L-band corrections are available worldwide. With Atlas, the positioning accuracy does not 
degrade as a function of distance to a base station, as the data content is not composed of a 
single base station’s information, but an entire network’s information. The VS330 can calculate a 
position with 4cm RMS (horizontal) accuracy in an industry-leading time of 20 minutes. 
 
To configure the receiver to use Atlas L-band, a subscription must be purchased. Then use 
Figure C-6 to configure your receiver to use Atlas. 
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GLONASS & BeiDou 
 
VS330 is available in its base form as L1 GPS G1 GLONASS, and B1 BeiDou. By adding multi-
frequency GPS, GLONASS and BeiDou, the number of available signals increases, thereby 
improving the ability to obtain and maintain a heading solution. For a heading calculation, GPS, 
GLONASS and BeiDou satellites are used interchangeably, as intersystem biases cancel inside 
the VS330—this translates into being able to work in more obstructed areas and maintain a 
GNSS heading solution. 

 

Supplemental Sensors 
 
The VS330 has an integrated gyro and two tilt sensors, which are enabled by default. Each 
supplemental sensor may be individually enabled or disabled. Both supplemental sensors are 
mounted on the printed circuit board inside the VS330. 
 
The sensors act to reduce the RTK search volume, which improves heading startup and 
reacquisition times. This improves the reliability and accuracy of selecting the correct heading 
solution by eliminating other possible, erroneous solutions. 
 
The Hemisphere GNSS Technical Reference Guide describes the commands and methodology 
required to recalibrate, query, or change the sensors status. 
 
Tilt Aiding 
 
The VS330’s accelerometers (internal tilt sensors) are factory calibrated and enabled by default. 
This constrains the RTK heading solution beyond the volume associated with just a fixed 
antenna separation. This is because the VS330 knows the approximate inclination of the 
secondary antenna with respect to the primary antenna. The search space defined by the tilt 
sensor will be reduced to a horizontal ring on the sphere’s surface by reducing the search 
volume. This considerably decreases startup and reacquisition times (see Figure 2-1). 
 

 

 
 

Figure 2-1: VS330’s Tilt Aiding 
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Gyro Aiding 

 
The VS330’s internal gyro offers several benefits. It reduces the sensor volume for an RTK 
solution. This shortens reacquisition times when a GNSS heading is lost because the satellite 
signals were blocked. The gyro provides a relative change in angle since the last computed 
heading, and, when used in conjunction with the tilt sensor, defines the search space as a 
wedge-shaped location (see Figure 2-2). 

 
Figure 2-2: VS330’s Gyro Aiding 

 
The gyro aiding accurately smoothes the heading output and the rate of turn. It provides an 
accurate substitute heading for a short period depending on the roll and pitch of the vessel, 
ideally seeing the system through to reacquisition. The gyro provides an alternate source of 
heading, accurate to within 1º per minute for up to three minutes, in times of GNSS loss for 
either antenna. If the outage lasts longer than three minutes, the gyro will have drifted too far 
and the VS330 begins outputting null fields in the heading output messages. There is no user 
control over the timeout period of the gyro. 
 
The gyro initializes itself at powerup and during initialization, or you can calibrate it as outlined in 
the Hemisphere GNSS Technical Reference Guide. For optimal performance, when the gyro is 
first initializing, the dynamics the gyro experiences during this warmup period are similar to the 
regular operating dynamics. For example, if you use the VS330 on a high speed, maneuverable 
craft, it is essential that when gyro aiding in the VS330 is first turned on, use it in an environment 
that has high dynamics for the first five to ten minutes instead of sitting stationary. 
 
With the gyro enabled, the gyro is also used to update the post HTAU smoothed heading output 
from the moving base station RTK GNSS heading computation. This means that if the HTAU 
value is increased while gyro aiding is enabled, there will be little to no lag in heading output due 
to vehicle maneuvers. The Hemisphere GNSS Technical Reference Guide includes information 
on setting an appropriate HTAU value for the application. 
 

Time Constants 
 

The VS330 incorporates user-configurable time constants that can provide a degree of 
smoothing to the heading, pitch, rate-of-turn (ROT), course-over-ground (COG), and speed 
measurements. You can adjust these parameters depending on the expected dynamics of the 
vessel. For example, increasing the time is reasonable if the vessel is very large and is not able 
to turn quickly or would not pitch quickly.  
 
The resulting values would have reduced “noise,” resulting in consistent values with time. 
However, if the vessel is quick and nimble, increasing this value can create a lag in 
measurements. Formulas for determining the level of smoothing are located in the Hemisphere 
GNSS Technical Reference Guide.  If you are unsure on how to set this value, it is best to be 
conservative and leave it at the default setting. 
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Heading Time Constant 

 
Use the $JATT,HTAU command to adjust the level of responsiveness of the true heading 
measurement provided in the $GPHDT message. The default value of this constant is 0.1 
seconds of smoothing when the gyro is enabled. The gyro is enabled by default, but can be 
disabled. By disabling the gyro, the equivalent default value of the heading time constant would 
be 0.5 seconds of smoothing. This is not automatic, and therefore it must be manually entered. 
Increasing the time constant increases the level of heading smoothing and increases lag. 

 
Pitch Time Constant 

 
Use the $JATT,PTAU command to adjust the level of responsiveness of the pitch measurement 
provided in the $PSAT,HPR message. The default value of this constant is 0.5 seconds of 
smoothing. Increasing the time constant increases the level of pitch smoothing and increases 
lag. 

 
Rate-of-Turn (ROT) Time Constant 

 
Use the $JATT,HRTAU command to adjust the level of responsiveness of the ROT 
measurement provided in the $GPROT message. The default value of this constant is 2.0 
seconds of smoothing. Increasing the time constant increases the level of ROT smoothing. 

 
Course-Over-Ground (COG) Time Constant 

 
Use the $JATT,COGTAU command to adjust the level of responsiveness of the COG 
measurement provided in the $GPVTG message. The default value of this constant is 0.0 
seconds of smoothing. Increasing the time constant increases the level of COG smoothing. COG 
is computed using only the primary GNSS antenna and its accuracy depends upon the speed of 
the vessel (noise is proportional to 1/speed). This value is invalid when the vessel is stationary. 

 
Speed Time Constant 

 
Use the $JATT,SPDTAU command to adjust the level of responsiveness of the speed 
measurement provided in the $GPVTG message. The default value of this parameter is 0.0 
seconds of smoothing. Increasing the time constant increases the level of speed measurement 
smoothing. 
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Installing the VS330 
 

Mounting the Antennas 
 
Hemisphere GNSS recommends mounting the antennas first, and then the mounting the 
receiver.  
 
When mounting the antennas consider the following: 

• Mounting orientation (parallel or perpendicular) 
• Proper antenna placement 
• Mounting options (magnetic, pole, or rail mounting) 

 
Antenna Options 
 
The standard VS330 kit does not include antennas. Your VS330 kit may contain a combination 
of the following antennas: A42, A43, A45, and/or A52. For example: 

• If you will be using beacon, your kit may include one A43 beacon antenna and one A42 
antenna (or one A43 and one A52). 

• If you will not be using beacon, your kit may include two A42 antennas, two A45 
antennas, or two A52 antennas. 

 
Mounting Orientation 

 
The VS330 outputs heading, pitch, and roll readings regardless of the orientation of the 
antennas. However, the relation of the antennas to the boat’s axis determines whether you will 
need to enter a heading, pitch, or roll bias. The primary antenna is used for positioning and the 
primary and secondary antennas, working in conjunction, output heading, pitch, and roll values. 
 
Regardless of which mounting orientation you use, the VS330 provides the ability to output the 
heave of the vessel. This output is available via the $GPHEV message. For more information on 
this message refer to the Hemisphere GNSS Technical Reference Guide. 
 
Parallel Orientation 

 
The most common installation is to orient the antennas parallel to, and along the centerline of, 
the axis of the boat. This provides a true heading. In this orientation: 

• If you use a gyrocompass, you can enter a heading bias in the VS330 to calibrate the 
physical heading to the true heading of the vessel. 

• You may need to adjust the pitch/roll output to calibrate the measurement if the Vector is 
not installed in a horizontal plane. 

 
Perpendicular Orientation 

 
You can also install the antennas so they are oriented perpendicular to the centerline of the 
boat’s axis. In this orientation: 

• You will need to enter a heading bias of +90° if the primary antenna is on the starboard 
side of the boat and -90° if the primary antenna is on the port side of the boat. 

• You will need to configure the receiver to specify the GNSS antennas are measuring the 
roll axis using $JATT,ROLL,YES. 

• You will need to enter a roll bias to properly output the pitch and roll values. 
• You may need to adjust the pitch/roll output to calibrate the measurement if the Vector is 

not installed in a horizontal plane.  
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Planning the Optimal Antenna Placement 

 
Proper antenna placement is critical to positioning accuracy. For the best results, orient the 
antennas so the antennas’ connectors face the same direction. Also, place the antennas: 

• With a clear view of the horizon 
• Above metal objects or other obstructions that may cause multipath 
• Away from other electronics and antennas 
• Along the vessel’s centerline 

 

 You must install the primary antenna along the vessel’s centerline; you 
cannot adjust the position readings if the primary antenna is installed off the centerline. 
Positions are computed for the primary antenna. 

 
Positions are computed for the primary antenna. 

• On a level plane 
• With a 10.0 m or 5.0 m maximum separation (default is 1.0 m) 

o With a dual-frequency activation, the maximum separation is 10.0 m 
o Without a dual-frequency activation, the maximum separation is 5.0 m 

• Away from radio frequencies 
• As high as possible 

 
Set the MSEP value to be accurate to within 1 to 2 cm. For more information on MSEP refer to 
the Hemisphere GNSS Technical Reference Guide). 
 
See Figure 3-1 below through Figure 3-3 for mounting orientation examples. 

 

 
Figure 3-1: Recommended Orientation and Resulting Signs of HPR Values 

Note: In the VS330 kit, install the A42 or A52 antenna as the primary antenna as it is 
used for positioning. 
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Figure 3-2: Alternate Orientation and Resulting Signs of HPR Values 
 
 

 
Figure 3-3: Antenna Installation: Cross-section of boat 
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Mounting Options 
 
You can mount the antennas with a magnetic mount, pole mount, or rail mount configuration. 
You can secure the antennas to a threaded pole or threaded mount using the included mounting 
adapters. 
 
Depending on the antennas included in your kit, you may need to use the included antenna 
height adapters to bring the antennas level. If the adapter is not used, you will need to enter a 
non-level bias calculation into the system (see “Q: I could not install my antennas at the same 
height. How do I calibrate for the height offset?” Appendix B, “FAQ.”) 

 

  The maximum allowable antenna separation is 10.0 m. Any 

greater distance may result in an incorrect heading. 

 
Magnetic Mount 
 
The following procedure assumes your kit contains one A43 beacon antenna and one A42 
antenna. If your kit contains an A52 antenna instead of an A42, follow the same steps. If your kit 
does not contain an A43 beacon antenna, mount both antennas in the same manner as outlined 
in the steps for the A42. 
 
Note: Your kit may not include a magnetic mount.  

 
You can screw the magnetic mount into the bottom of the antenna and 
mount it to any metal surface. If there are no metal surfaces, use the 
zinc disc and foam adhesive included in your kit to mount the antenna. 
 
To mount the antennas using the magnetic mount: 

1. Select a location and orientation that meet the requirements outlined in “Mounting 
Orientation” and “Planning the Optimal Antenna Placement”. 

2. A42 antenna only: Unlike the A43, the A42 antenna does not include a threaded 
mounting hole. You must attach the mounting bracket (see at right) using the four 
screws in your kit. 

3. Attach the magnetic mount extension to the magnetic base plate. 

 
4. Thread the magnetic mount into the mounting bracket on the bottom of the A42 or A52 

antenna or into the bottom of the A43 antenna. 
 

  When threading the magnetic mounts, hand tighten only. Damage 
resulting from over-tightening may void your warranty. 

 

Note: Photos at right and in step 4 show the zinc disc 
attached to the magnetic base plate. You will only need 
the zinc disc if mounting the antenna to a non-metal 
surface (see steps 6 through 9). 
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If you are mounting the antenna on a metal surface, go to step 5. 
 
If you are mounting the antenna on a non-metal surface and need to use the metal disc and 
foam adhesive, skip step 5 and complete steps 6 through 9. 

 
5. Place the antenna in the desired location, ensuring the 

antenna is secure in its mounting position (end of metal 
surface mounting procedure). 

6. Clean and dry the surface where you will attach the zinc 
disc. 

7. Remove the backing from one side of the foam adhesive and 
press the adhesive onto the zinc plate (at right). 

8. Remove the backing from the other side of the foam 
adhesive and press the zinc disc onto the mounting surface 
on the vessel, applying firm pressure to ensure good 
adhesion. 

9. Place the antenna on top of the zinc disc, ensuring the 
antenna is secure in its mounting position. 

 
Pole Mount 
 
The following procedure assumes your kit contains one 
A43 beacon antenna and one A42 antenna. If your kit 
contains an A52 antenna instead of an A42, follow the 
same steps. If your kit does not contain an A43 beacon 
antenna, mount both antennas in the same manner as 
outlined in the steps for the A42. 
 
You can pole-mount the antennas using existing 
hardware on your vessel.  
 
To mount the antennas using a pole mount: 
 

1. Select a location and orientation that meet the requirements outlined in 
“Mounting Orientation” and “Planning the Optimal Antenna Placement”. 

2. A42 antenna only: Unlike the A43, the A42 antenna does not include a 
threaded mounting hole. You must attach the mounting base using the four 
screws included in your kit (see at right). 

3. Thread the pole mount (not included) into the mounting bracket on the 
bottom of the A42 antenna or into the bottom of the A43 antenna. 

A42 A43 
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  When threading the pole mounts, hand tighten only. Damage resulting from 
over-tightening may void your warranty. 

 
4. Mark and drill any mounting holes necessary for the pole mounts. 

 
Rail Mount 
 
You can rail mount the antennas using existing hardware on your vessel. 
 
To rail mount the antennas: 

1. Select a location and orientation that meet the requirements listed in “Mounting 
Orientation” and “Planning the Optimal Antenna Placement”. 

2. Use appropriate hardware to securely attach the antenna to the railing. 
 
 

Routing and Securing the Antenna Cable 
 

  The VS330 receiver provides 5 VDC across the antenna ports. Connection to 
incompatible devices may damage equipment. 

 
To route and secure the antenna cables, review the following guidelines. Each antenna in your 
kit requires a 50 Ω impedance antenna extension cable, such as RG-58U (up to a maximum of 
15 m (49 ft.) in length), for proper operation. 
 

• The GNSS receiver inside the VS330 requires a minimum input gain of 10 dB (and 
maximum of 40 dB before saturation will occur). The antennas offer 28 dB of gain, so 
the loss budget to accommodate for cable losses is 18 dB. 

• Regardless of the cable material and length you choose, ensure the cable losses are 
less than 18 dB of attenuation. Due to variances in the antenna gain and practical 
attenuation of cable materials and connectors, Hemisphere GNSS recommends 
reducing this budget to 15 dB; this budget is present to overcome the resulting 
attenuation of an RF cable. 

• When deciding on an antenna location, consider the amount of cable required: A longer 
cable of the same material will result in a higher loss than a shorter one. If the overall 
loss of the longer cable exceeds 15 dB, change the cable material (this normally means 
a more expensive material that has a larger diameter and less flexibility). The standard 
cables included with the VS330 are of the RG58 material family and their attenuation is 
~0.8 dB/m. Including connector losses, the nominal loss of these RF cables is ~10 dB, 
which is within the tolerable loss budget. If a 15 m or 20 m cable run is required, 
sophisticated materials are required. 

  

A42 A43 
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For more information on cable length or low-loss cable, contact your dealer or Hemisphere 
GNSS Technical Support. Table 3-1 provides a summary of readily available cable materials 
with 50 Ω impedance. 

 

Table 3-1: Cable losses (not including connector losses) 
 

Material Loss at GPS L1 (1.575 GHz) 

RG58 0.78 dB/m 

RG8 0.36 dB/m 

Times Microwave LMR400 0.15 dB/m 

 
For additional cable guidelines see “Routing and Connecting the Cables”. 

 

Mounting the Receiver 
 
Hemisphere GNSS recommends mounting the antennas first and then the mounting the 
receiver. Use the enclosed kit to mount the receiver. When mounting the VS330 receiver, 
adhere to the following guidelines: 

• Install the receiver inside and away from the elements in a location that minimizes 
vibration, shock, extreme temperatures, and moisture 

• Position the receiver horizontally with its display facing the primary antenna 
• Ensure the front panel (menu screen, LEDs, buttons) is visible and accessible 
• Ensure the back panel (ports, connectors) is easily accessible to connect/ switch out 

cables 
 
Figure 3-4 shows the dimensions (including attached mounting brackets) of the VS330.  
Refer to Figure 3-4 when following the receiver mounting procedure. 
 

  
 

Figure 3-4: VS330 Dimensions with Mounting Brackets  
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To mount the receiver: 
1. Locate the thumbscrews, nuts, and brackets included in your kit. 
2. Slide the nuts through the opening (circled at right) along both sides of the receiver. 

 
 

 
 

 
 

3. Place the bracket alongside the receiver and insert the thumbscrews (two thumbscrews 
per bracket) so they screw into the nuts. 

  
4. Using the remaining holes in the brackets (two holes per bracket) screw down the 

brackets in your preferred location.  
 

Note: HGNSS does not provide the screws for this step. 

 
 

Routing and Connecting the Cables 
 
Adhere to the following when routing and connecting cables: 
 

Do… Do Not… 
Ensure your power cable can reach an appropriate power 
source 

Run cable in areas of excessive heat 

Ensure antenna cables can reach from the antennas to the 
receiver 

Expose cable to corrosive chemicals 

Use your data cable to connect to a data storage device, 
computer, or other device that accepts GNSS data 

Crimp or excessively bend cable 

Coil up excess cable near unit Place tension on cable 
Secure along the cable route using plastic tie wraps as 
necessary 

Run cable near high voltage or strong RF noise and 
transmitter sources 

Ensure the power source is between 8 V and 36 V when 
connecting the power cable to the power source 

 

 
Improperly installed cables near machinery can be dangerous.  
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Connecting the Receiver to External Devices 
 
You can connect the VS330 to external devices via Port A and Port B on the back of the unit. 
 

 
Figure 3-5: VS330 Port Connections 

 
Figure 3-6 shows the pinout for Port A (ODU 9-pin) and Port B (DB9), and Table 3-2 provides 
descriptions of the pinouts for each port. Both ports communicate at the RS-232 interface level 
with external data loggers, navigation systems, and other devices, while Port A can also transmit 
at the RS-422 level. 
 
The default baud rates, NMEA message types, and update rates for both ports are listed in 
“Default Parameters”. If the NMEA data messages you desire are different from the default 
values, you will need to select those also. Use the Config Wizard to select your NMEA message 
types and update rates per port (see “Using the Config Wizard”). 
 
 
Table 3-2: Port A/Port B Pinout descriptions 

 
 

Figure 3-6: Port A (top) and 
Port B (bottom) Pinouts 

 

  

Pin Port A Port B 

1 Port A Rx (RS-232) Not connected 

2 Signal ground Port B Tx 
(RS-232) 

3 Signal ground Port B Rx 
(RS-232) 

4 1 PPS timing output Not connected 

5 Port A Tx+ 
(RS-422) 

Signal ground 

6 Port A Tx- 
(RS-422) 

Not connected 

7 Event marker input Not connected 

8 Port A Tx (RS-232) Not connected 

9 Reserved 5V output, 350 mA 
max 



VS330 User Guide Chapter 3 – Installing the VS330 Page 27 of 47 

 

 

Figure 3-7 shows the I/O cable that connects to Port A. 

 

Figure 3-7: I/O cable 
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Default Parameters 
The following represents the standard configuration for the VS330. For more information on 
these commands refer to the Hemisphere GNSS Technical Reference Guide. 

 

Table 3-3: Default Parameters 
 

Setting Parameter Description 
Elevation Mask: 10 10 Degree Elevation Mask 
RTK Timeout 2700s RTK correction will be dropped after 2700s 
Decimal Precision 5 Decimal values in NMEA messages will have 5 digits of precision 
Diff Source:  SBAS SBAS will be used 
COG TAU 0 See Time Constants 
Speed TAU 0 See Time Constants 
HTAU 0.1 See Time Constants 
HRTAU 2.0 See Time Constants 
MSEP 1 This is the measured separation (in meters) between the primary and secondary antennas. This 

value should be precisely measured (within 2cm) and entered into the receiver. The default 
value is 1m. The minimum value is 0.5m and the maximum value is 10.0m if the VS330 has a 
dual frequency activation and 5.0m if the VS330 does not have a dual frequency activation 

GYROAID YES The internal gyro is enabled by default. This provides two benefits: 
1) It shortens reacquisition times when a GPS heading is lost because of obstruction of 

satellite signals. It does this by reducing the search volume required for solution of 
the RTK. 

 
2) It provides an accurate substitute heading for a short period (depending on the roll 

and pitch of the vessel) ideally seeing the system through to reacquisition. 

TILTAID YES The sensors act to reduce the RTK search volume, which improves heading startup and 
reacquisition times. This improves the reliability and accuracy of selecting the correct heading 
solution by eliminating other possible, erroneous solutions. 

HBIAS 0 0 degrees will be added to offset heading value 
Port A Baud 19200  
Port A NMEA  GGA 1Hz, HDT 10Hz ROT 10Hz HPR 1Hz 
Port B Baud 19200  
Port B NMEA  GGA 1Hz, HDT 10Hz ROT 10Hz HPR 1Hz 

 
For a complete list of messages, refer to the Hemisphere GNSS Technical Reference Guide. 

Note: Use the $JSAVE command to save changes you make to the VS330 configuration for the 
changes to be present in subsequent power cycles. If you change any default values and issue a 
$JRESET command, verify your settings to ensure you consistently get a correct heading.  
To reset the VS330 to its default parameters, you can re-install the configuration file (shown below)—
contact your dealer or Hemisphere GNSS Technical Support for information on obtaining and re-
installing the configuration file. 
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Operating the V330 
 

Powering the Receiver On/Off 
 
The power button on the VS330 is located on the front panel (circled below). When you first 
apply power to the unit it turns on. 

 
Figure 4-1: VS330 Front Panel with Power Button 

 
The VS330 accepts an input voltage of 8 to 36 VDC via the power cable. The supplied power 
should be continuous and clean for best performance. Table D-5 provides the power 
specifications of the VS330. 
 

  Do not apply a voltage higher than 36 VDC. This will damage the receiver and 
void the warranty. Also, do not attempt to operate the VS330 with the fuse bypassed as 
this will void the warranty. 

 
The VS330 features reverse polarity protection to prevent damage if the power leads are 
accidentally reversed. Although the VS330 proceeds through an internal startup sequence when 
you apply power, it will be ready to communicate immediately. 
 
Initial startup may take 5 to 15 minutes depending on the location. Subsequent startups will 
output a valid position within 1 to 5 minutes depending on the location and time since the last 
startup. 
 
The VS330 may take up to 5 minutes to receive a full ionospheric map from SBAS. Optimum 
accuracy is obtained once the VS330 is processing corrected positions using complete 
ionospheric information. 
 
To power on the VS330: 
 

1. Connect the ends of the VS330 power cable to a clean power source providing 8 to 36 
VDC. 

 
2. Press and hold the soft power switch on the front panel until the splash screen appears. 

 
To power off the VS330: 
 

1. Press and hold the soft power switch on the front panel until the screen goes blank. 

Note: Hemisphere GNSS recommends you use a weather-tight connection and 
connector if the connection is located outside. 
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LED Indicators 
 
The VS330 includes five LEDs located to the left of the display on the front panel (shown at 
right). 
 

 
Figure 4-2: VS330 LEDs 

 
 
Table 4-1 below describes each LED indicator. 
 

Table 4-1: LED indicators 
 

Indicator Description/Function 

HEADING • Valid GNSS heading available 

• Illuminates solid green when the receiver achieves a valid heading 
solution from the GNSS receiver. You must see PRIM GNSS and 
SEC GNSS illuminated before a heading solution is possible. 

• If the GNSS solution is no longer available, the LED powers off. 

DIFF • DGNSS position indicator 

• Illuminates solid green when the receiver achieves a differential 
position and a pseudorange residual of better than 10.0 m. 

• If the residual value is worse than the current threshold, the LED 
blinks green indicating differential mode has been attained but the 
residual has not met the threshold. 

SEC GNSS • Secondary antenna is tracking 4 or more satellites 

• Illuminates solid amber when the secondary antenna is tracking 
four or more satellites. 

PRIM GNSS • Primary antenna is tracking 4 or more satellites 

• Illuminates solid amber when the primary antenna is tracking four or 
more satellites. 

POWER • Power indicator 

• Illuminates solid red when the receiver is powered-on. 
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Startup 
 
When you power on the VS330 the Hemisphere GNSS splash screen appears followed by the 
main screen, or Top menu (see at top right). Press the Down Arrow button to display the 
remaining items on the Top menu (see at bottom right). 
 

 
 
You use the menus to view and configure system data and settings for the following Top menu 
items: 

• Vector 
• GNSS 
• Differential (menu item will be the selected differential source, such as SBAS or 

Autonomous) 
• Config Wizard 
• System Setup 
• Data Logging 

 
For a complete menu path of each Top menu item, see Appendix C, Menu Map. 
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Using the Menus 
 
The VS330 menu system is designed for easy setup and configuration of the unit in or out of the 
field and supports multiple languages. You can perform most configuration tasks entirely through 
the menu without having to connect to a computer. 

 
 
Table 4-2 describes the indicators to the right of specific menu items. 
 

Table 4-2: Menu item indicators 
 

Indicator Purpose Example 

 

 

Display 
indicator 

Goes to the indicated 
submenu. 

This indicator also appears 
to the right of the “Back” and 
“Top Menu” menu items. 

• Press Enter when 
“Back” is selected to 
return to the previous 
menu. 

• Press Enter when “Top 
Menu” is selected to 
return to the Top menu. 

1. On the Top menu press the Down Arrow 

button to highlight System Setup. The 
Display indicator appears to the right of 
System Setup. 

2. Press Enter to display the System Setup 
menu. 

3. Press the Down Arrow button again to 
highlight the Display Format option and 
then press Enter. The items on the 
Display Format menu appear and the 
Select indicator appears to the right of 
Disp Update (the first item on the Display 
Format menu). 

4. Press Enter on the Disp Update item. 
The Display indicator changes to the 
Select indicator. 

5. Press the Up Arrow or Down Arrow 

button to scroll through the available 
options (such as 1Hz and 5Hz). 

6. Press Enter on the highlighted option to 
select it. That option is now the setting for 
the menu item and the Select indicator 
changes back to the Display indicator. 

 

 
Select 
indicator 

Scrolls within a menu to 
highlight an option to select. 

 
To return the menu system to the factory default configuration: 

• Press and hold the Enter and Up Arrow buttons until the splash screen disappears 
(Enter and Power share the same soft switch).  

The VS330 front panel contains the three soft buttons shown at right. The Enter button also 
functions as the power switch (see “Powering the Receiver On/Off” for more information). 
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Configuring the VS330 
 
The Config Wizard menu guides you through various configuration options, enabling you to save 
up to five different configurations that are useful when using the VS330 on different vessels or 
for different applications. 
 
Config Wizard Menu 
 
This section describes the basic Config Wizard options you need to set to get up and running. 
Figure 4-3 outlines the menu structure of the Config Wizard menu. 

 
 

 
Figure 4-3: Config Wizard Menu 
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Using the Config Wizard 
 
The basic setup instructions outlined in this section assume the antennas are: 

• Installed parallel to, and along the centerline of, the vessel’s axis 
• Separated by 1.0 m 

 
If this is not the case, you will need to enter the actual antenna separation and bias in the Config 
Wizard. 
 
1. Select Config Wizard > Proceed Wizard. The Proceed Wizard menu appears. 
2. Select Create New to create a new configuration. You are prompted to enter a name for 

your configuration. In addition to the Name you can set the options shown at right (also 
shown in Figure 4-3 on the previous page). 

 
Note: For help on using the menus to view and setting values see “Using the Menus”.  

 

 
If you are editing an existing name, for characters you want to replace simply select a different 
character. If the new name is shorter and you need to delete unneeded characters to the right: 
 

a. After you change the final character in the new name press the Enter button repeatedly 
until the last character is highlighted. 

b. Scroll through the list of characters until you reach “  ” and press the Enter button to 
delete the character. The cursor moves to the left. 

c. Repeat step b for each additional rightmost character you want to delete. 

d. Scroll through the list of characters until you reach “ ” and press the Enter button to 
accept the name. You are returned to the previous menu and the name you entered 
appears next to “Enter Name.” 

 
4. Set a DGNSS source: From the same menu, select DIFF.  

The options are:  
• SBAS (default) 
• Beacon Autonomous RTK 
• L-band 
• Extern RTCM (External RTCM) 

  

3. Enter a name: 
a. Use the arrow buttons to select a character 

and then press the Enter button to save the 
character. The cursor moves to the right. 

b. Repeat step a for each additional character 
in the name. 

c. Scroll through the list of characters until you 
reach  and press the Enter button to accept 
the name. You are returned to the previous 
menu and the name you entered appears 
next to “Enter Name.” 
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5. Change the type of GNSS data message sent to the data ports: Select either Data Port A or 

Data Port B from the menu list. 
6. Set the elevation cutoff angle: Select Elev Mask and set the angle between 0° and 45°. The 

default value is 5°. 
7. Set the maximum DGNSS age: The maximum DGNSS age is 2700 seconds (45 minutes) by 

default. 
8. Configure baud rates: If the default baud rate on the selected port does not match that of the 

external device you are connecting to, you will need to configure the Baud Rate, using the 
Port A or Port B entries. 
 
4800, 9600, 19200, 38400, 57600, and 115200 are the available baud rates. 
 

9. Enable/disable aiding features: The Aiding Features menu enables you to turn the gyroaid 
and tiltaid features on or off. For more information on disabling the aiding features, see 
“Disabling Tilt Aiding” or “Disabling Gyro Aiding”. 

10. Adjust time constants: While the default time constants settings will work for most users, if 
you have a large, slow turning vessel or a small, quick-moving, vessel you may want to 
adjust the time constants to reduce heading start up and re acquisition times. 

 
For details on configuring the time constants, see “Adjusting the Time Constants”. 
 
11. Enter a heading bias: If you did not install the antenna’s parallel to and along the vessel’s 

centerline, you will need to enter a heading bias in the Heading field of the Bias, Neg, Tilt 
menu. The heading bias (-180º to +180°) compensates for any offset from the centerline. 

 
12. Enter a pitch/roll bias: Enter the bias for pitch or roll (-15° - +15°) to compensate for any 

offset from the boat’s centerline. Enter this bias in the Pitch/Roll field of the Bias, Neg, Tilt 
menu. 

13. Enter the antenna separation: If you did not install the antennas 1.0 m apart, enter the actual 
antenna separation In the Ant. Sep field. The available range is 0 - 10.0 m. 

14. Configure antenna for roll: Most users install the antennas for pitch; however, if you install 
the antennas for roll, you will need to configure the VS330 for roll. In the Create New menu 
set the Pitch/Roll setting to Roll. 

15. Save your configuration: To save your new configuration, select the Save to Location field. 
You will be prompted for a location to save your configuration. 

 
Select one of the empty slots, noted by the name Not Used or select a slot with an existing 
configuration to overwrite it. 
 
After your configuration is saved, you must select it from the Config Wizard in order to activate it. 
You may then continue to enter different receiver configurations without upsetting the current 
operation of the receiver. Re- enter the Config Wizard and select the configuration to use. 

  

Note: If you installed the antennas for roll (perpendicular to the boat’s axis), rather than 
pitch, you must enter the heading bias (+/-90°). You must also enter the bias for roll 
(see below). 
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Disabling the Aiding Features 
 
While the default settings will work for most users, you can configure the tilt and gyro aiding 
features to further reduce heading startup and re-acquisition times. 
 
Disabling Tilt Aiding 
 
The VS330’s tiltaid (accelerometer) is enabled by default and constrains the RTK heading 
solution to reduce startup and re acquisition times. The tiltaid is pre-calibrated at the factory; 
however, if you experience any tilt measurement offset, you can recalibrate the tilt sensor via the 
Calibrate Tilt option in the Vector menu. See Vector menu for a menu map on how to access this 
feature. 
 
Note: Make sure the receiver is perfectly level before recalibrating the tiltaid.  
 
The only times you may need to disable the tiltaid feature are: 

• If you were unable to install the VS330 on a level plane with the antennas. The tilt 
sensor is located inside the VS330, so it is important that you install the VS330 on a 
level horizontal plane. 

 

  If you were unable to install the VS330 in a horizontal plane with the antennas, 
you must disable tiltaid. Failure to do so may cause erratic equipment behavior. 

 
• If troubleshooting, to ensure the receiver is working properly. 

 
You can turn tilt aiding off either through the Config Wizard or Vector menus. 

 
Disabling Gyro Aiding 
 
The VS330’s internal gyro-aid is enabled by default. The gyro: 

• Shortens re-acquisition times when satellites are obstructed and heading is lost, by 
reducing the search volume required for the RTK solution, and 

• Provides accurate substitute headings for a short period (depending on the roll and pitch 
of the vessel) ideally seeing you through to re-acquisition. 

 
The only time you might need to disable the gyro-aid is during troubleshooting, to ensure the 
receiver is working properly. 

 

  Do not exceed turn rates of 90º/sec. The VS330 uses gyro measurements to 
obtain a heading rate measurement and the gyro cannot measure beyond this rate. 

 
You can turn the gyroaid feature off either through the Config Wizard menu or the Vector menu. 
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Adjusting the Time Constants 
 
The VS330’s default settings are acceptable for most users; however, you can set the time 
constants to further smooth heading, course-over-ground (COG), and speed measurements. 
Table 4-3 provides an overview of the time constant values you can set in the Config Wizard, 
including the formulas for finding the optimal value of each time constant for your vessel. 
 

Table 4-3: Time Constants 
 

Time 
Constant 

Description 

COGTAU 
(Course Over 
Ground) 

Adjust the responsiveness to the course over ground measurement. If vessel 
is small and dynamic, leave this value at 0.0 s to be conservative. If the 
vessel is large and resistant to motion, you may want to increase this value. 

Default value: 0.0 s 
Range: 0.0 to 60 s 

Formula: cogtau (s) = 10 / max rate of change of course (°/sec) 

HRTAU 
(Rate of Turn) 

Adjust the responsiveness to the rate of heading change. If vessel is large and 
unable to turn quickly, you may want to increase this value. 

Default value: 2.0 s with gyro enabled 
Range: 0.0 to 60 s 

Formula: hrtau (s) = 10 / max rate of the rate of turn (°/s2) 

HTAU 
(Heading) 

Adjust the responsiveness to true heading. If vessel is large and unable to 
turn quickly, you may want to increase this value. 

For longer baselines (10 m) HTAU should be between 0.1 and 0.5, since the 
gyro introduces noise. 

Default value: 0.1 s with gyro enabled 
Range: 0.0 to 60 s 

Formula:  htau (s) = 40 / max rate of turn (°/s)  with gyro ON 

htau (s) = 10 / max rate of turn (°/s)  with gyro OFF 

PTAU 
(Pitch) 

Adjust the responsiveness to pitch. If vessel is large and unable to pitch 
quickly, may want to increase this value. 

Default value: 0.5 s 
Range: 0.0 to 60 s 

Formula: ptau (s) = 10 / max rate of pitch (°/s) 

SPDTAU 
(Speed) 

Adjust the responsiveness to speed. If vessel is small and dynamic, leave this 
value at 0.0 s to be conservative. If the vessel is large and resistant to motion, 
you may want to increase this value. 

Default value: 0.0 s 
Range: 0.0 to 60 s 

Formula: spdtau (s) = 10 / max acceleration (m/s2) 
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Connecting to Existing Navigation Systems 
 
Most users connect the VS330 to their existing navigation system during installation. These 
users will receive the VS330’s position and heading updates through the interface of their 
existing system. 

 
Viewing GNSS/DGNSS Status 
 
Most users will receive position and heading information through their on-board navigation 
system. If you have not connected the VS330 to an existing navigation system, or are 
troubleshooting your unit, you may need to view GNSS, DGNSS, or beacon status on the 
VS330’s display screen. 

 
Do I Have a Signal? 
 
Figure 4-2 shows which LEDs on the VS330 will indicate GNSS, DGNSS or Beacon signal lock 
when illuminated. If you lose the differential signal lock, Hemisphere GNSS TRACER™ 
technology allows the VS330 to perform well for 40 minutes or more with aging differential 
GNSS correction data. The amount of time you can “coast” depends on the degree of tolerable 
drift. 
 

 
 

How Good is the Quality of My Signal? 
 
In addition to the LED indicators for signal lock, 
the VS330’s display indicates signal quality. 
The bars along the top of the display represent 
the quality of the GNSS and DGNSS (or if 
applicable, beacon) signal. 
 
The first group of bars shows the GNSS signal; 
the second group shows the DGNSS or beacon signal. Each bar represents a distinct channel 
and its associated signal quality. The higher the bar, the better the signal. 
  

 
Note: If using autonomous or external correction mode, the DGNSS signal indicator will not 
appear in the display. 

 
DGNSS (SBAS) 
 
The differential correction (or SBAS) signal indicator reflects the quality of each satellite signal, 
or the bit error rate (BER). A full bar height reflects a signal lock and a BER of 0. A bar height 
only 2 pixels tall reflects a signal loss, or BER, of 500 or greater. Bar heights in between reflect 
intermediate degrees of signal quality. For example, when using WAAS two satellites are 
available, so two BERs are provided. 

 
  

Note: To obtain a full set of SBAS corrections, the VS330 must receive the ionospheric map 
over a period of a few minutes. After this, the receiver can “coast” until the next set of 
corrections has been received. 
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Beacon 
 
The beacon indicator reflects the quality of the beacon signal, or the signal strength (SS) and the 
signal-to-noise ratio (SNR). A full bar height reflects a signal lock, SS>=35, and SNR>=24. A bar 
height only 2 pixels tall reflects a signal loss, or SS and SNR values of 0. Bar heights in between 
reflect intermediate degrees of signal quality. 
 
If using beacon, the first bar indicates SS signal quality; the second bar indicates SNR signal 
quality. 

 
USB Data Logging 
 
When you insert a USB flash drive into the VS330, the Data Logging menu indicates you can 
start recording (logging data) and displays the free space on the flash drive (see Figure 4-4). 
When you start logging data the “Start Recording” indicator changes to “End <filename>.” 

 

 
 

Figure 4-4: USB flash drive indicators on Data Logging menu 

 
 

  Stop data logging before removing the USB flash drive from the VS330. 
Failure to do so may result in a loss of data. 

 
 
Selecting the Data File Type and Log Options 

 
You can log the following data types to a USB flash drive: 

• RAW - binary, NMEA, and other data options (see Table 4-4) 
• KML - Google Earth KML format with latitude, longitude and height 
• CSV - comma-separated value (CSV) format with time, latitude, longitude, and height 
• PostPro - VS330 automatically turns on the appropriate messages for post processing 
• Debug - VS330 logs high speed data for troubleshooting purposes (contact Hemisphere 

GNSS Technical Support for more information) 
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Table 4-4: RAW Data Log Options 
 

Format Description 

Raw (binary) For raw (binary) data logging, you may also want the receiver configuration to be inserted 
into the file. If you select this option the file will start with the receiver configuration 
comprised of the replies to the $JI, $JK, $JT, and $JSHOW queries. 

NMEA National Marine Electronics Association (NMEA 0183) - industry standard data 
transmission format 

CMR Proprietary data correction format 

DFX Hemisphere GNSS-proprietary data correction format 

ROX Hemisphere GNSS-proprietary data correction format 

RTCM Radio Technical Commission for Maritime Services - industry standard data correction format 

 
To select a data logging type: 

1. Select Data Logging > Config > FileType. 
2. Press the Up/Down Arrow buttons until your preferred data type appears then 

press Enter. 
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When logging using the RAW data type (File Type > RAW as shown in Figure 4-5) you can 
select which data to log and at what rate by selecting Data Logs and then making the desired 
selections on the Data Logs menu. 
 

 
Figure 4-5: Data Logging > Config > Data Logs menu 
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Note: Logged data options are limited by your receiver subscriptions (certain options may not 
appear on the Data Logs menu without a specific subscription). For GLONASS: GNGNS, 
GNGSA, GLGSV, Bin62, Bin65, Bin66, and Bin69 only appear on the Data Logs menu if you are 
authorized to receive GLONASS. For BeiDou: GBGSV, Bin35,Bin36 and Bin39 only appear on 
the Data Logs menu if you are authorized to receive BeiDou.  
 
To view your subscriptions press System Setup > Software Disp > Authorizations. 

 
Logging Data to a File 
 
You can log data to a file that the VS330 auto-generates or you can manually enter a filename to 
which to log data. You can append data to or overwrite data on a manually-named file; however, 
you cannot append data to or overwrite data on an VS330-generated file. 

 
To log data to an VS330 auto-generate filename: 

1. Select Data Logging > Config. 
2. If Auto-Name displays No select Auto-Name and then press Enter. 
3. Select Yes and then press Enter. 
4. Select Back to return to the Data Logging menu. 
5. Select Start Recording to begin logging data. The Start Recording option changes 

to End <filename>. 
6. Select End <filename>. 

 
To log data to a manually-created filename: 

1. Select Data Logging > Config. 
2. If Auto-Name displays Yes select Auto-Name and then press Enter. 
3. Select No and press Enter. The Enter Name and Mode menu items appear below 

Auto-Name. 
4. Enter a filename: 

a. Select Enter Name and press Enter. 
b. Enter the desired characters for the filename and then scroll to the return 

character and press Enter. 
5. Select the mode: 

a. Select Mode and press Enter. 
b. Select Append to log data to new file or to append data to an existing file 

(based on the filename in step 4) and press Enter. 
or 

Select Overwrite to overwrite an existing file (based on the filename in step 4) 
and press Enter. 

 

  No warnings are given to confirm overwriting a previous file. 

 
6. Select Back to return to the Data Logging menu. 
7. Select Start Recording to begin logging data. The Start Recording option 

changes to End <filename>. 
8. Select End <filename>. 
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Data Post-Processing 
 
After you log data you can then process the data with a Receiver Independent Exchange 
(RINEX) format software utility. Hemisphere GNSS Rinex conversion software is available from 
the Hemisphere GNSS website . 

 
Make sure you select PostPro as the file type before logging the data you will use for post 
processing (see “Selecting the Data File Type and Log Options”). 

 
To post-process raw data: 

1. Log the raw data to the USB flash drive inserted in the VS330. Make sure you properly 
end your data logging before removing the flash drive in Step 2. 

2. Remove the flash drive from the VS330 then insert the drive in a PC with Hemisphere 
GNSS’ Rinex conversion software installed. 

3. Run the Rinex conversion software. 
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RTK 

 
RTK Requirements 
 
RTK provides the highest accuracy. You can set up the RTK system using the VS330.  
 
To setup RTK you will need the following: 

• GNSS receiver 
• GNSS antennas 
• Power source 

 
Setting Up RTK 
 
To set up the VS330 for RTK: 

1. Select your differential corrector: From the Top menu press Differential > Include then 
set your preferred RTK corrector to YES (ROX set to YES in example below). When 
RTK is achieved, the Differential menu shows the corrector type next to InUse and RTK 
below Include. 

 

 
 

2. From the Top menu press Differential > RTK then set DiffPort to your preferred 
differential port and set DiffBaud to your preferred baud rate (PORT B and 19200, 
respectively, in example below). 
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RTK Operation 
 
After you set up your RTK system, the status LEDs indicated in Table 5-1 show the progress 
levels of RTK: 
 

Table 5-1: RTK LED indicators 
 

LED Function LED Color Description 

 Power Red Illuminates solid red when the receiver is 
powered on. 

 

 

 Primary GPS 
Lock 

Yellow Illuminates solid yellow when the receiver 
achieves a solid GNSS lock.  

 

 Secondary 
GPS Lock 

Yellow Illuminates solid yellow when the receiver 
achieves a solid GNSS lock. 

 

 

 Differential 
Tracking / RTK 
Lock 

Green If the residual value is worse than the 
current threshold, the LED blinks green 
indicating differential mode has been 
attained but the residual has not met the 
threshold. 

Illuminates solid green when the receiver 
achieves RTK position lock. 

 

 

 
The VS330 will output standard NMEA messages through Port A or Port B. Set the message 
and port output as preferred (see “Config Wizard Menu” for more information on message 
output). 
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Appendix A: Troubleshooting 
 
Table A-1 provides troubleshooting for common problems. 
 

 
Table A-1: Troubleshooting 
 

Symptom Possible Solution 

Receiver fails to power • Verify polarity of power leads 

• Check integrity of power cable connectors 

• Check power input voltage (8 to 36 VDC) 

• Check current restrictions imposed by power source (minimum available should be > 1.0 A) 

No data from VS330 • Check receiver power status to ensure the receiver is powered (an ammeter can be used for  this) 

• Verify desired messages are activated (using  $JSHOW in any terminal program) 

• Ensure the baud rate of the VS330 matches that of the receiving device 

• Check integrity and connectivity of power and data cable connections 

Random data from VS330 • Verify the RTCM or binary messages are not being output accidentally (send a $JSHOW 
command) 

• Ensure the baud rate of the VS330 matches that of the remote device 

• Potentially, the volume of data requested to be output by the VS330 could be higher than the current 
baud rate supports (try using 19200 as the baud rate for all devices or reduce the amount of data 
being output) 

No GNSS lock • Verify the VS330 has a clear view of the sky 

• Verify the lock status of GNSS satellites 

No beacon lock • Verify the receiver is tuned to the correct frequency and bit rate 

• Ensure beacon signal coverage is expected in your area 

• Ensure environmental noise is not masking the signal, reducing the SNR reading 

No SBAS lock • Verify the VS330 has a clear view of the sky 

• Verify the lock status of SBAS satellites (this can be done with VectorPC - monitor BER value) 

• Set SBAS mode to automatic with the 
$JWAASPRN,AUTO command 

SBAS lock is only possible if you are in an appropriate SBAS region; currently, there is limited SBAS 
availability in the southern hemisphere. 
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Table A-1: Troubleshooting (continued) 
 

Symptom Possible Solution 

No heading or incorrect 
heading value 

• Check CSEP value is fairly constant without varying more than 1 cm (0.39 in)—larger variations 
may indicate a high multipath environment and require moving the receiver location 

The standard antenna mounting configuration provides a 0.5° heading accuracy at 95% confidence. If 
you require more performance, you will need to increase the antenna separation (maximum 
recommended separation is 10.0 m). See Table D-1 for antenna separation specifications. 

• Re-calibrate the tilt sensor with $JATT,TILTCAL command if heading is calculated then lost at 
consistent time intervals 

• Heading is from primary GNSS antenna to secondary GNSS antenna 

• $JATT,SEARCH command forces the VS330 to acquire a new heading solution (unless gyro is 
enabled) 

• Enable GYROAID to provide heading for up to three minutes during GNSS signal loss 

• Enable TILTAID to reduce heading search times 

• Monitor the number of satellites and SNR values for both antennas within VectorPC—at least four 
satellites should have strong SNR values 

• Potentially, the volume of data requested to be output by the VS330 could be higher than the current 
baud rate supports (try using 19200 as the baud rate for all devices or reduce the amount of data 
being output) 

No RTK Position • Verify the baud rate of the RTCM input port matches the baud rate of the external source 

• Verify the pinout between the RTCM source and the RTCM input port (transmit from the source must 
go to receive of the RTCM input port and grounds must be connected) 

• Ensure corrections are being transmitted to the correct port—using the $JDIFF,PORTB command on 
Port A will cause the receiver to expect the corrections to be input through Port B 
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Appendix B: Frequently Asked Questions 
 
This appendix covers power, communication and external RTCM questions. 
 
Q: Can COAST technology work with corrections from an external source? 
 
A: Yes, the VS330 will operate in a similar fashion with COAST technology as when using SBAS 
or Beacon corrections. However, SBAS corrections have the advantage that they are separated 
into separate error components, allowing the VS330 to anticipate how errors will change over 
the coasting period with more consistent accuracy and for a longer period than regular RTCM 
range corrections. 
 
Q: My VS330 does not appear to be communicating. What do I do? 
 
A: This could be one of the following issues: 

• Examine the power cable and its connector for signs of damage. 
• Ensure you are properly powering the system with the correct voltage (8 to 36 

VDC) by measuring the voltage at the receiver end of the power cable when the 
cable is connected to the power source. 

• Check current restrictions imposed by power source (minimum available should be 
> 1.0 A). 

• Verify the display has turned on and that time is incrementing in the upper right 
corner of the display, and configure the COM port baud rates appropriately through 
the menu system. 

• Verify polarity of power leads. 
• Check the 1.0 A inline power cable fuse. 
• Since you are required to terminate the power input with your choice of connector, 

ensure you have made a good connection to the power supply. 
 
Consult the troubleshooting section of the other device’s reference manual to determine if 
there is an issue with that device. 

 
Q: Am I able to configure the two serial ports with different baud rates? 
 
A: Yes, the ports are independent. For example, you may have one port set to 4800 and the 
other to 19200 or vice versa. 
 
Q: Am I able to have the VS330 output different NMEA messages through the two ports? 
 
A: Yes, you may have different NMEA messages turned on for the two serial ports. Further, 
these NMEA messages may also be at different update rates. 
 
Q: How do I determine the current configuration of the VS330? 
 
A: You can view the current configuration from various screens of the menu, which show all 
configurable items of the receiver. Alternately, you can select Config Wizard> Use Previous to 
return the receiver to a previously saved (known) configuration. 
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Q: My VS330 does not appear to be using corrections from an external correction source. 
What could be the problem? 
 
A: This could be due to a number of issues. Check the following items: 

• Make sure the corrections are of an RTCM SC-104 protocol. 
• Verify the baud rates of the port used by the VS330 match that of the external 

correction source. 
• The external correction source should be using an 8-data bit, no parity, 1 stop bit 

(8-N-1) serial port configuration. 
• Inspect the cable connection to ensure there are no signs of damage. 
• Check the pinout information for the cables to ensure the transmit line of the 

external correction source is connected to the receive line of the VS330’s serial 
port and that the signal grounds are connected. 

 
Save the configuration as the profile named “RTCM” in the Config Wizard, cycle the power and 
load the RTCM profile. 
 
Q: Why am I not getting data from the VS330? 
 
A: There are several possible reasons for this. Check the following items. 

• Check receiver power status LED to ensure the receiver is powered. 
• Verify the VS330 is locked to a valid DGNSS signal (this can often be done on the 

receiving device or with VectorPC). 
• Verify the VS330 is locked to GNSS satellites (this can often be done on the receiving 

device or with PocketMax). 
• Check the integrity and connectivity of power and data cable connections. 

 
Q: Why am I getting random data from VS330? 
 
A: There are three possible reasons for this. Check the following items. 

• Verify the RTCM or the Bin95 and Bin96 messages are not being output accidentally 
(send a $JSHOW command). 

• Verify the baud rate settings of VS330 and remote device match correctly. 
• Potentially, the volume of data requested to be output by the VS330 could be higher 

than the current baud rate supports. Try increasing the baud rate to 38400 for all 
devices or reduce the amount of data being output. 

 
Q: I could not install my antennas at the same height. How do I calibrate for the height 
offset? 
 
A: You may enter a non-level bias calculation that adjusts the pitch/roll output to calibrate the 
measurement if the antenna array is not installed on a horizontal plane. 
 
To calibrate the pitch/roll reading, send the following command: 

$JATT,PBIAS,x<CR><LF> 
 
where x is a bias (in degrees) that will be added to the pitch/roll measurement. The 
acceptable pitch bias range is -15.0º to 15.0º (default is 0.0º). 

 
To determine the current pitch compensation angle, send the following command: 

$JATT,PBIAS<CR><LF> 
 
The pitch/roll bias is added after the negation of the pitch/roll measurement (if so 
invoked with the $JATT,NEGTILT command). 
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Vector Menu 

GNSS Menu 

Differential Menu 

Config Wizard Menu 

System Setup Menu 

Data Logging Menu 
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Appendix C: Menu Map 
 

This appendix shows the complete menu map for each menu (listed below) on the VS330 Top 
menu: 

• Vector 
• GNSS 
• Differential (menu item will be the selected differential source, such as SBAS or 

Autonomous) 
• Config Wizard 
• System Setup 
• Data Logging 

 

Vector Menu 
 
Use the Vector menu to view and adjust Vector settings. Options vary depending on whether 
you select Pitch or Roll and include such items as aiding features, time constants, heading bias, 
and antenna separation. 

 
Figure C-1 Vector Menu 
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GNSS Menu 
 
Use the GNSS menu to view and edit your GNSS settings. Settings include the data port 
outputs, specific positioning parameters, UTC time offset, and satellite visibility and positioning 
information. 
 
 

 
Figure C-2: GNSS Menu 
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Differential Menu 
 
Use the Differential menu to view or change your differential settings. The following available 
differential sources depend on the configuration you purchased. 

• SBAS 
• Beacon (RTCM2) - available with purchased unlock code 
• RTK (CMR, ROX, RTCM3) 
• L-band - available with purchase of Atlas subscription 
• None (Autonomous) 

 
To select the differential source: 

1. Press Differential > Include then set each format you may use to Yes. For example, if 
you will be using Beacon, set RTCM2 to Yes. 

2. Press Back to return to the previous menu level, press InUse, then select your preferred 
differential source. For example, if you will be using Beacon, select Beacon (RTCM2 will 
be displayed when finished). 

 
Figure C-3 through Figure C-7 show the complete menu maps for the SBAS, Beacon, RTK, L-
band, and Autonomous, respectively. The Include menu (at right) in each of these figures shows 
all available formats. If you have not purchased unlock codes for L-band and Beacon, Atlas and 
RTCM2 (Beacon) menu items will not appear on your menu. 

 
Figure C-3: SBAS Menu 
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Figure C-4: RTK Menu 

 
 

 
Figure C-5: Beacon Menu 
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Figure C-6: L-band Menu 
 
 
 

Figure C-7: Autonomous Menu 
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Config Wizard Menu 
 
The Config Wizard walks you through basic settings to get up and running. See “Configuration 
Wizard” to view the Config Wizard menu map. 
 

System Setup Menu 
 
The System Setup menu allows you quickly view and edit current system settings. General 
settings include such items as current applications, units, baud rates, logs, LED contrast, 
subscription code, display orientation (you can flip the display 180° by selecting YES under Flip 
Display), and language. 
 
 

 
 

Figure C-8: System Setup Menu 
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Data Logging Menu 
 
The Data Logging menu allows you to log or output job data, view USB flash drive free storage 
space, set up file auto-naming, and view what type of data you are logging. 
 
 

 
Figure C-9: Data Logging Menu 
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A43 Antenna  

A52 Antenna  
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Appendix D: Technical Specifications 
 

VS330 Receiver Specifications 
 
Table D-1 through Table D-8 list the technical specifications of the VS330. 

 

Table D-1: VS330 GNSS Sensor  
 

Item Specification 

Receiver type Vector GNSS L1/L2 RTK 

Signals received GPS, GLONASS, BeiDou and Galileo1
 

Channels Two 270-channel 

GNSS sensitivity -142 dBm 

SBAS tracking 3-channel, parallel tracking 

Update rate 10 Hz standard, 20 Hz available by subscription 

Horizontal  RMS (67%) 2DRMS (95%) 

accuracy RTK2
 10 mm + 1 ppm 20 mm + 2 ppm 

 L-band 3,4
 0.04 m 0.08 m 

 SBAS (WAAS)3 0.25 m 0.50 m 
 Beacon3

 0.25 m 0.50 m 
 Autonomous, no SA3

 1.2 m 2.5 m 

Heading accuracy < 0.17˚ RMS @ 0.5 m antenna separation 
< 0.09˚ RMS  @ 1.0 m antenna separation 
< 0.04˚ RMS @ 2.0 m antenna separation 
< 0.02˚ RMS @ 5.0 m antenna separation 
< 0.01˚ RMS @10.0 m antenna separation 

Pitch/roll accuracy < 1º RMS 

Heave accuracy 30 cm (DGNSS), 10 cm (RTK)5 

Timing (1PPS) 
accuracy 

20 ns 

Rate of turn 90º/s maximum 

Cold start time < 40 s typical (no almanac or RTC) 

Warm start time < 20 s typical (almanac and RTC) 

Hot start time < 5 s (almanac, RTC, and position) 

Heading fix < 10 s typical (valid position) 

Maximum speed 1,850 kph (999 kts) 

Maximum altitude 18,288 m (60,000 ft) 

 
Table D-2: VS330 Beacon Sensor  
 

Item Specification 

Channels 2-channel, parallel tracking 

Frequency range 283.5 to 325 kHz 

Operating modes Manual, automatic, and database 

Compliance IEC 61108-4 beacon standard 

 
  



VS330 User Guide Appendix D-Technical Specifications Page D3 

 

 
 

 
 
 
 
Table D-3: VS330 L-band Sensor  
 

Item Specification 

Receiver Type Single Channel 

Channels 1530 to 1560 MHz 

Sensitivity -130 dBm 

Channel spacing 5.0 kHz 

Satellite selection Manual and automatic 

Reacquisition time 15 seconds (typical) 

 
 

Table D-4: VS330 Communication  
 

Item Specification 

Serial ports 2 full-duplex RS-232, 1 full-duplex RS-422 

USB ports 1 USB-A 

Baud rates 4800 - 115200 

Data I/O protocol NMEA 0183, Crescent binary6
 

Correction I/O protocol RTCM v2.3 (DGNSS), RTCM v3 (RTK), CMR (RTK), CMR+ 

(RTK)7 

Timing output 1 PPS CMOS, active high, rising edge sync, 10 kΩ, 10 pF  load 

 
Table D-5: VS330 Power  
 

Item Specification 

Power input voltage 8 to 36 VDC 

Power consumption < 6.2 W nominal (GNSS L1/L2 L-band) 
< 5.3 W nominal (GNSS L1/L2 RTK) 

Current consumption < 0.52 A nominal (GNSS L1/L2 L-band) 
< 0.44 A nominal (GNSS L1/L2 RTK) 

Power isolation 500 V 

Reverse polarity protection Yes 

Antenna short circuit protection Yes 

Antenna input impedance 50 Ω 

 
Table D-6: VS330 Environmental  
 

Item Specification 

Operating temperature -30°C to +70°C (-22°F to +158°F) 

Storage temperature -40°C to +85°C (-40°F to +185°F) 

Humidity 95%, non-condensing 

Enclosure rating IP66 (IEC 60529) 

Shock and vibration Mechanical Shock: EP455 Section 5.14.1 Vibration: EP455 

Section 5.15.1 Random 

EMC CE (IEC 60945 Emissions and Immunity), FCC Part 15, Subpart B, 

CISPR 22 

IMO wheelmarked certification No 

 
 
 
 
  



VS330 User Guide Appendix D-Technical Specifications Page D4 

 

 
 

 
 
 
 
 
 
 

Table D-7: BS330 Mechanical  
 

 

Item Specification 

Dimensions 20.2 L x 12.0 W x 7.5 H (cm) 
8.0 L x 4.7 W x 3.0 H (in) 

Weight ~1.1 kg (2.5 lb) 

Status indications (LEDs) Power, primary GNSS lock, secondary GNSS lock, 
differential lock, DGNSS position, heading, RTK lock, L-
band lock 

Power switch Front panel soft switch 

Power connector 2-pin ODU metal circular 

Data connectors (1) DB9 sealed 
(1) 9-pin ODU metal circular 

Antenna connectors (2) TNC female 

 
 

Table D-8: Aiding Devices 
 

Item Specification 

Gyro Provides smooth heading, fast heading reacquisition and reliable < 1˚ per minute 

heading for periods up to 3 minutes when loss of GNSS has occurred.8 

Tilt sensors Provide pitch, roll data and assist in fast start-up and reacquisition of heading 

solution. 

 
1Upgrade required 

2Depends on multipath environment, number of satellites in view, satellite geometry, baseline length (for local services), and ionospheric activity 

3Depends on multipath environment, number of satellites in view, and satellite geometry 

4Requires an Atlas subscription 

5Based on a 40 second time constant 

 6Hemisphere GNSS proprietary 

7Receive only, does not transmit this format 

8Under static conditions 
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A42 Antenna Specifications 
 
Table D-9 through Table D-12 list the technical specifications of the A42 antenna. 
 

Table D-9:A42 GNSS Sensor  
 

Specification Description 

GNSS reception GPS L1/L2/L5, GLONASS L1/L2, Beidou B1/B2/B3, 
SBAS, L-band, and Galileo E1/E5a and b 

GNSS frequency 1.165 to 1.253 GHz 
1.525 to 1.613 GHz 

LNA gain 30 dB 

LNA noise 2.0 dB, typical 

 
Table D-10: A42 Power  
 

Specification Description 

Input voltage 3.3 to 12 VDC 

Input current 35 mA, typical 

 
Table D-11: A42 Mechanical  
 

Specification Description 

Enclosure Aluminum base with ASA plastic cap 

Dimensions 7.0 H x 13.0 D (cm) 
2.9 H x 5.1 D (in) 

Weight 0.38 kg (0.84 lb) 

Mount 5/8” female thread 

RF connector TNC straight 

 
Table D-12 A42 Environmental  
 

Specification Description 

Operating temperature -40°C to +70°C (-40°F to +158°F) 

Storage temperature -40°C to +85°C (-40°F to +185°F) 

Enclosure rating IP69K 

Shock and vibration EP455 
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A43 Antenna Specifications 
 
Table D-13 through Table D-18 list the technical specifications of the A43 antenna. 
 

 

Table D-13: A43 GNSS Sensor  
 

Specification Description 

GNSS reception GPS L1/L2/L5, GLONASS L1/L2, BeiDou B1/B2/B3, 
SBAS, L-band, and Galileo E1/E5a and b 

GNSS frequency 1.165 to 1.253 GHz 
1.525 to 1.613 GHz 

LNA gain 30 dB 

LNA noise 2.0 dB, typical 

 
Table D-14: A43 L-band Sensor  
 

Specification Description 

L-band frequency 1.525 - 1.585 GHz 

L-band LNA gain 30 dB 

 
Table D-15: A43 Beacon Sensor  
 

Specification Description 

Beacon frequency 283.5 - 325 kHz 

Beacon LNA gain 30 dB 

 
Table D-16: A43 Power  
 

Specification Description 

Input voltage 5 to 12 VDC 

Input current 40 - 50 mA, typical 

 
Table D-17: A43 Mechanical  
 

Specification Description 

Enclosure Lexan 

Dimensions 10.4 H x 14.5 D (cm) 
4.1 H x 5.7 D (in) 

Weight 0.73 kg (1.6 lb) 

Mount 1" coarse thread (5/8" adapter available) 

Connector TNC 
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Table D-18: A43 Environmental 
 

Specification Description 

Storage temperature -40°C to +85°C (-40°F to +185°F) 

Operating temperature -40°C to +70°C (-40°F to +158°F) 

Enclosure rating IP69K 

Shock and vibration EP 455 
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A52 Antenna Specifications 
 
Table D-19 through Table D-22 list the technical specifications of the A52 antenna. 
 

Table D-19: A52 GNSS Sensor  
 

Specification Description 

GNSS reception GPS L1/L2/L5, GLONASS L1/L2, BeiDou B1/B2/B3, 
SBAS, L-band and Galileo E1/E5a and b 

GNSS frequency 1.165 to 1.253 GHz 
1.525 to 1.613 GHz 

LNA gain 30 dB 

LNA noise 2.0 dB, typical 

 
Table D-20: A52 Power  
 

Specification Description 

Input voltage 3.3 to 12 VDC 

Input current 35 mA, typical 

 
Table D-21: A52 Mechanical  
 

Specification Description 

Enclosure Aluminum base with ASA plastic cap 

Dimensions 7.6 H x 18.5 D (cm) 
3.0 H x 7.3 D (in) 

Weight 0.78 kg (1.71 lb) 

Mount 5/8” female thread 

RF connector TNC straight or right angle 

 
Table D-22: A52 Environmental  
 

Specification Description 

Operating temperature -40°C to +70°C (-40°F to +158°F) 

Storage temperature -40°C to +85°C (-40°F to +185°F) 

Enclosure rating IP69K 

Shock and vibration EP455 

 
 

Note: The phase center variation is less than 3 mm at GPS L1 and L2 for elevations above 15 degrees. 
 
 
 
 
 



 

 
 

 

 
 
 

End User License Agreement 

IMPORTANT - This is an agreement (the "Agreement") between you, the end purchaser ("Licensee") and Hemisphere GNSS Inc. ("Hemisphere") which permits Licensee to use the 

Hemisphere software (the "Software") that accompanies this Agreement. This Software may be licensed on a standalone basis or may be embedded in a Product. Please read and ensure 

that you understand this Agreement before installing or using the Software Update or using a Product. 

 
In this agreement any product that has Software embedded in it at the time of sale to the Licensee shall be referred to as a "Product". As well, in this Agreement, the use of a Product shall 

be deemed to be use of the Software which is embedded in the Product. 

 
BY INSTALLING OR USING THE SOFTWARE UPDATE OR THE PRODUCT, LICENSEE THEREBY AGREES TO BE LEGALLY BOUND BY THE TERMS OF THIS AGREEMENT. IF YOU DO NOT AGREE TO 

THESE TERMS, (I) DO NOT INSTALL OR USE THE SOFTWARE, AND (II) IF YOU ARE INSTALLING AN UPDATE TO THE SOFTWARE, DO NOT INSTALL THE UPDATE AND PROMPTLY DESTROY IT. 

 
HEMISPHERE PROVIDES LIMITED WARRANTIES IN RELATION TO THE SOFTWARE. AS WELL, THOSE WHO USE THE EMBEDDED SOFTWARE DO SO AT THEIR OWN RISK. YOU SHOULD 

UNDERSTAND THE IMPORTANCE OF THESE AND OTHER LIMITATIONS SET OUT IN THIS AGREEMENT BEFORE INSTALLING OR USING THE SOFTWARE OR THE PRODUCT. 

 
1. LICENSE. Hemisphere hereby grants to Licensee a non-transferable and non-exclusive license to use the Software as embedded in a Product and all Updates (collectively the 

"Software"), solely in binary executable form. 

2. RESTRICTIONS ON USE. Licensee agrees that Licensee and its employees will not directly or indirectly, in any manner whatsoever: 

a. install or use more copies of the Software than the number of copies that have been licensed; 

b. use or install the Software in connection with any product other than the Product the Software was intended to be used or installed on as set out in the documentation that 

accompanies the Software. 

c. copy any of the Software or any written materials for any purpose except as part of Licensee's normal backup processes; 

d. modify or create derivative works based on the Software; 

e. sub-license, rent, lease, loan or distribute the Software; 

f. permit any third party to use the Software; 

g. use or operate Product for the benefit of any third party in any type of service outsourcing, application service, provider service or service bureau capacity; 

h. reverse engineer, decompile or disassemble the Software or otherwise reduce it to a human perceivable form; 

i. Assign this Agreement or sell or otherwise transfer the Software to any other party except as part of the sale or transfer of the whole Product. 

3. UPDATES. At Hemisphere's discretion Hemisphere may make Updates available to Licensee. An update ("Update") means any update to the Software that is made available to 

Licensee including error corrections, enhancements and other modifications. Licensee may access, download and install Updates during the Warranty Period only. All Updates 

that Licensee downloads, installs or uses shall be deemed to be Software and subject to this Agreement. Hemisphere reserves the right to modify the Product without any 

obligation to notify, supply or install any improvements or alterations to existing Software. 

4. SUPPORT. Hemisphere may make available directly or through its authorized dealers telephone and email support for the Software. Contact Hemisphere to find the authorized 

dealer near you. As well, Hemisphere may make available user and technical documentation regarding the Software. Hemisphere reserves the right to reduce and limit access to 

such support at anytime. 

5. BACKUPS AND RECOVERY. Licensee shall back-up all data used, created or stored by the Software on a regular basis as necessary to enable proper recovery of the data and 

related systems and processes in the event of a malfunction in the Software or any loss or corruption of data caused by the Software. Licensee shall assume all risks of loss or 

damage for any failure to comply with the foregoing. 

6. OWNERSHIP. Hemisphere and its suppliers own all rights, title and interest in and to the Software and related materials, including all intellectual property rights. The 

Software is licensed to Licensee, not sold. 

7. TRADEMARKS. "Hemisphere GNSS", "Crescent", "Eclipse" and the associated logos 

are trademarks of Hemisphere. Other trademarks are the property of their respective owners. Licensee may not use any of these trademarks without the consent of their respective 

owners. 

 
8. LIMITED WARRANTY. Hemisphere warrants solely to the Licensee, subject to the exclusions and procedures set forth herein below, that for a period of one (1) year from the 

original date of purchase of the Product in which it is embedded (the "Warranty Period"), the Software, under normal use and maintenance, will conform in all material respects 

to the documentation provided with the Software and any media will be free of defects in materials and workmanship. For any Update, Hemisphere warrants, for 90 days from 

performance or delivery, or for the balance of the original Warranty Period, whichever is greater, that the Update, under normal use and maintenance, will conform in all material 

respects to the documentation provided with the Update and any media will be free of defects in materials and workmanship. Notwithstanding the foregoing, Hemisphere does 

not warrant that the Software will meet Licensee's requirements or that its operation will be error free. 

9. WARRANTY EXCLUSIONS. The warranty set forth in Section (8) will not apply to any deficiencies caused by (a) the Product not being used as described in the documentation 

supplied to Licensee, (b) the Software having been altered, modified or converted in any way by anyone other than Hemisphere approved by Hemisphere, (c) any malfunction of 

Licensee's equipment or other software, or (d) damage occurring in transit or due to any accident, abuse, misuse, improper installation, lightning (or other electrical discharge) or 

neglect other than that caused by Hemisphere. Hemisphere GNSS does not warrant or guarantee the precision or accuracy of positions obtained when using the Software (whether 

standalone or embedded in a Product). The Product and the Software is not intended and should not be used as the primary means of navigation or for use in safety of life 

applications. The potential lpositioning and navigation accuracy obtainable with the Software as stated in the Product or Software documentation serves to provide only an estimate 

of achievable accuracy based on specifications provided by the US Department of Defense for GPS positioning and DGPS service provider performance specifications, where 

applicable. 

10. WARRANTY DISCLAIMER. EXCEPT AS EXPRESSLY SET OUT IN THIS AGREEMENT, HEMISPHERE MAKES NO REPRESENTATION, WARRANTY OR CONDITION OF ANY KIND TO 

LICENSEE, WHETHER VERBAL OR WRITTEN AND HEREBY DISCLAIMS ALL REPRESENTATIONS, WARRANTIES AND CONDITIONS OF ANY KIND INCLUDING FITNESS FOR A 

PARTICULAR PURPOSE, MERCHANTABILITY, ACCURACY, RELIABILITY OR THAT THE USE OF THE SOFTWARE WILL BE UNINTERRUPTED OR ERROR-FREE AND HEREBY DISCLAIMS ALL 

REPRESENTATIONS, WARRANTIES AND CONDITIONS ARISING AS A RESULT OF CUSTOM, USAGE OR TRADE AND THOSE ARISING UNDER STATUTE. 

11. LIMITS ON WARRANTY DISCLAIMER. Some jurisdictions do not allow the exclusion of implied warranties or conditions, so some of the above exclusions may not apply to 

Licensee. In that case, any implied warranties or conditions which would then otherwise arise will be limited in duration to ninety (90) days from the date of the license of the 

Software or the purchase of the Product. The warranties given herein give Licensee specific legal rights and Licensee may have other rights which may vary from jurisdiction to 

jurisdiction. 

12. CHANGE TO WARRANTY.No employee or agent of Hemisphere is authorized to change the warranty provided or the limitation or disclaimer of warranty provisions. All such 

changes will only be effective if pursuant to a separate agreement signed by senior officers of the respective parties. 

13. WARRANTY CLAIM. In the event Licensee has a warranty claim Licensee must first check for and install all Updates that are made available. The warranty will not otherwise be 

honored. Proof of purchase may be required. Hemisphere does not honor claims asserted after the end of the Warranty Period. 

14. LICENSEE REMEDIES. In all cases which involve a failure of the Software to conform in any material respect to the documentation during the Warranty Period or a breach of a 

warranty, Hemisphere's sole obligation and liability, and Licensee's sole and exclusive remedy, is for Hemisphere, at Hemisphere's option, to (a) repair the Software, (b) replace 

the Software with software conforming to the documentation, or (c) if Hemisphere is unable, on a reasonable commercial basis, to repair the Software or to replace the Software 

with conforming software within ninety (90) days, to terminate this Agreement and thereafter Licensee shall cease using the Software. Hemisphere will also issue a refund for the 

price paid by Licensee less an amount on account of amortization, calculated on a straight-line basis over a deemed useful life of three (3) years. 

15. LIMITATION OF LIABILITY. IN NO EVENT WILL HEMISPHERE BE LIABLE TO LICENSEE FOR ANY INCIDENTAL, CONSEQUENTIAL, SPECIAL OR INDIRECT DAMAGES INCLUDING ARISING 

IN RELATION TO ANY LOSS OF DATA, INCOME, REVENUE, GOODWILL OR ANTICIPATED SAVINGS EVEN IF HEMISPHERE HAS BEEN INFORMED OFTHE POSSIBILITY OF SUCH LOSS OR 

DAMAGE. FURTHER, IN NO EVENT WILL HEMISPHERE'S TOTAL CUMULATIVE LIABILITY HEREUNDER, FROM ALL CAUSES OF ACTION OF ANY KIND, EXCEED THE TOTAL AMOUNT 

PAID BY LICENSEE TO HEMISPHERE TO PURCHASE THE PRODUCT. THIS LIMITATION AND EXCLUSION APPLIES IRRESPECTIVE OF THE CAUSE OF ACTION, INCLUDING BUT NOT 

LIMITED TO BREACH OF CONTRACT, NEGLIGENCE, STRICT LIABILITY, TORT, BREACH OF WARRANTY, MISREPRESENTATION OR ANY OTHER LEGAL THEORY AND WILL SURVIVE A 

FUNDAMENTAL BREACH. 

16. LIMITS ON LIMITATION OF LIABILITY. Some jurisdictions do not allow for the limitation or exclusion of liability for incidental or consequential damages, so the above  limitation or 

 



   

 

 

 
exclusion may not apply to Licensee and Licensee may also have other legal rights which may vary from jurisdiction to jurisdiction. 

17. BASIS OF BARGAIN. Licensee agrees and acknowledges that Hemisphere has set its prices and the parties have entered into this Agreement in reliance on the limited 

warranties, warranty disclaimers and limitations of liability set forth herein, that the same reflect an agreed-to allocation of risk between the parties (including the risk that a 

remedy may fail of its essential purpose and cause consequential loss), and that the same forms an essential basis of the bargain between the parties. Licensee agrees and 

acknowledges that Hemisphere would not have been able to sell the Product at the amount charged on an economic basis without such limitations. 

18. PROPRIETARY RIGHTS INDEMNITY. Hemisphere shall indemnify, defend and hold harmless Licensee from and against any and all actions, claims, demands, proceedings, liabilities, 

direct damages, judgments, settlements, fines, penalties, costs and expenses, including royalties and attorneys' fees and related costs, in connection with or arising out of any actual 

infringement of any third party patent, copyright or other intellectual property right by the Software or by its use, in accordance with this Agreement and documentation, PROVIDED 

THAT: (a) Hemisphere has the right to assume full control over any action, claim, demand or proceeding, (b) Licensee shall promptly notify Hemisphere of any such action, claim, 

demand, or proceeding, and (c) Licensee shall give Hemisphere such reasonable assistance and tangible material as is reasonably available to Licensee for the defense of the 

action, claim, demand or proceeding. Licensee shall not settle or compromise any of same for which Hemisphere has agreed to assume responsibility without Hemisphere's prior 

written consent. Licensee may, at its sole cost and expense, retain separate counsel from the counsel utilized or retained by Hemisphere. 

19. INFRINGEMENT. If use of the Software may be enjoined due to a claim of infringement by a third party then, at its sole discretion and expense, Hemisphere may do one of the 

following: (a) negotiate a license or other agreement so that the Product is no longer subject to such a potential claim, (b) modify the Product so that it becomes non- infringing, 

provided such modification can be accomplished without materially affecting the performance and functionality of the Product, (c) replace the Software, or the Product, with 

non-infringing software, or product, of equal or better performance and quality, or (d) if none of the foregoing can be done on a commercially reasonable basis, terminate this 

license and Licensee shall stop using the Product and Hemisphere shall refund the price paid by Licensee less an amount on account of amortization, calculated on a straight-line 

basis over a deemed useful life of three (3) years. 

The foregoing sets out the entire liability of Hemisphere and the sole obligations of Hemisphere to Licensee in respect of any claim that the Software or its use infringes any third 

party rights. 

 
20. INDEMNIFICATION. Except in relation to an infringement action, Licensee shall indemnify and hold Hemisphere harmless from any and all claims, damages, losses, liabilities, 

costs and expenses (including reasonable fees of lawyers and other professionals) arising out of or in connection with Licensee's use of the Product, whether direct or indirect, 

including without limiting the foregoing, loss of data, loss of profit or business interruption. TERMINATION. Licensee may terminate this Agreement at any time without cause. 

Hemisphere may terminate this Agreement on 30 days notice to Licensee if Licensee fails to materially comply with each provision of this Agreement unless such default is cured 

within the 30 days. Any such termination by a party shall be in addition to and without prejudice to such rights and remedies as may be available, including injunction and other 

equitable remedies. Upon receipt by Licensee of written notice of termination from Hemisphere or termination by Licensee, Licensee shall at the end of any notice period (a) cease 

using the Software; and (b) return to Hemisphere (or destroy and provide a certificate of a Senior Officer attesting to such destruction) the Software and all related material and 

any magnetic or optical media provided to Licensee. The provisions of Sections 6), 7), 8), 9), 10), 15), 21), 26) and 27) herein shall survive the expiration or termination of this 

Agreement for any reason. 

21. EXPORT RESTRICTIONS. Licensee agrees that Licensee will comply with all export control legislation of Canada, the United States, Australia and any other applicable country's laws 

and regulations, whether under the Arms Export Control Act, the International Traffic in Arms Regulations, the Export Administration Regulations, the regulations of the United 

States Departments of Commerce, State, and Treasury, or otherwise as well as the export control legislation of all other countries. 

22. PRODUCT COMPONENTS. The Product may contain third party components. Those third party components may be subject to additional terms and conditions. Licensee is required to 

agree to those terms and conditions in order to use the Product. 

23. FORCE MAJEURE EVENT. Neither party will have the right to claim damages as a result of the other's inability to perform or any delay in performance due to unforeseeable 

circumstances beyond its reasonable control, such as labor disputes, strikes, lockouts, war, riot, insurrection, epidemic, Internet virus attack, Internet failure, supplier failure, act 

of God, or governmental action not the fault of the non-performing party. 

24. FORUM FOR DISPUTES. The parties agree that the courts located in Calgary, Alberta, Canada and the courts of appeal there from will have exclusive jurisdiction to resolve any 

disputes between Licensee and Hemisphere concerning this Agreement or Licensee's use or inability to use the Software and the parties hereby irrevocably agree to attorn to the 

jurisdiction of those courts. Notwithstanding the foregoing, either party may apply to any court of competent jurisdiction for injunctive relief. 

25. APPLICABLE LAW. This Agreement shall be governed by the laws of the Province of Alberta, Canada, exclusive of any of its choice of law and conflicts of law jurisprudence. 

26. CISG. The United Nations Convention on Contracts for the International Sale of Goods will not apply tothis Agreement or any transaction hereunder. 

27. GENERAL. This is the entire agreement between Licensee and Hemisphere relating to the Product and Licensee's use of the same, and supersedes all prior, collateral or 

contemporaneous oral or written representations, warranties or agreements regarding the same. No amendment to or modification of this Agreement will be binding unless in 

writing and signed by duly authorized representatives of the parties. Any and all terms and conditions set out in any correspondence between the parties or set out in a purchase 

order which are different from or in addition to the terms and conditions set forth herein, shall have no application and no written notice of same shall be required. In the event 

that one or more of the provisions of this Agreement is found to be illegal or unenforceable, this Agreement shall not be rendered inoperative but the remaining provisions shall 

continue in full force and effect. 



   

 

 

 
Warranty Notice 

COVERED PRODUCTS: This warranty covers all products manufactured by Hemisphere GNSS and purchased by the end purchaser (the "Products"), unless otherwise specifically and 

expressly agreed in writing by Hemisphere GNSS. 

LIMITED WARRANTY: Hemisphere GNSS warrants solely to the end purchaser of the Products, subject to the exclusions and procedures set forth below, that the Products sold to such 

end purchaser and its internal components shall be free, under normal use and maintenance, from defects in materials, and workmanship and will substantially conform to Hemisphere 

GNSS's applicable specifications for the Product, for a period of 12 months from delivery of such Product to such end purchaser (the ”Warranty Period”). Repairs and replacement 

components for the Products are warranted, subject to the exclusions and procedures set forth below, to be free, under normal use and maintenance, from defects in material and 

workmanship, and will substantially conform to Hemisphere GNSS's applicable specifications for the Product, for 90 days from performance or delivery, or for the balance of the original 

Warranty Period, whichever is greater. 

EXCLUSION OF ALL OTHER WARRANTIES. The LIMITED WARRANTY shall apply only if the Product is properly and correctly installed, configured, interfaced, maintained, stored, and operated in 

accordance with Hemisphere GNSS's relevant User’s Manual and Specifications, AND the Product is not modified or misused. The Product is provided “AS IS” and the implied warranties of 

MERCHANTABILITY and FITNESS FOR A PARTICULAR PURPOSE and ALL OTHER WARRANTIES, 

express, implied or arising by statute, by course of dealing or by trade usage, in connection with the design, sale, installation, service or use of any products or any component thereof, 

are EXCLUDED from this transaction and shall not apply to the Product. The LIMITED WARRANTY is IN LIEU OF any other warranty, express or implied, including but not limited to, any 

warranty of MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE, title, and non-infringement. 

LIMITATION OF REMEDIES. The purchaser’s EXCLUSIVE REMEDY against Hemisphere GNSS shall be, at Hemisphere GNSS's option, the repair or replacement of any defective Product 

or components thereof. The purchaser shall notify Hemisphere GNSS or a Hemisphere GNSS's approved service center immediately of any defect. Repairs shall be made through a 

Hemisphere GNSS approved service center only. Repair, modification or service of Hemisphere GNSS products by any party other than a Hemisphere GNSS approved service center 

shall render this warranty null and void. The remedy in this paragraph shall only be applied in the event that the Product is properly and correctly installed, configured, interfaced, 

maintained, stored, and operated in accordance with Hemisphere GNSS's relevant User’s Manual and Specifications, AND the Product is not modified or misused. NO OTHER REMEDY 

(INCLUDING, BUT NOT LIMITED TO, SPECIAL, INDIRECT, INCIDENTAL, CONSEQUENTIAL OR CONTINGENT DAMAGES FOR LOST PROFITS, LOST SALES, INJURY TO PERSON OR PROPERTY, OR ANY 

OTHER INCIDENTAL OR CONSEQUENTIAL LOSS) SHALL BE AVAILABLE 

TO PURCHASER, even if Hemisphere GNSS has been advised of the possibility of such damages. Without limiting the foregoing, Hemisphere GNSS shall not be liable for any 

damages of any kind resulting from installation, use, quality, performance or accuracy of any Product. 

HEMISPHERE IS NOT RESPONSIBLE FOR PURCHASER’S NEGLIGENCE OR UNAUTHORIZED USES OF THE PRODUCT. IN NO EVENT SHALL Hemisphere GNSS BE IN ANY WAY 

RESPONSIBLE FOR ANY DAMAGES RESULTING FROM PURCHASER’S OWN NEGLIGENCE, OR FROM OPERATION OF THE PRODUCT IN ANY WAY OTHER THAN AS SPECIFIED IN 

Hemisphere GNSS's RELEVANT USER’S MANUAL AND SPECIFICATIONS. Hemisphere GNSS is NOT 

RESPONSIBLE for defects or performance problems resulting from (1) misuse, abuse, improper installation, neglect of Product; (2) the utilization of the Product with hardware or 

software products, information, data, systems, interfaces or devices not made, supplied or specified by Hemisphere GNSS; (3) the operation of the Product under any specification 

other than, or in addition to, the specifications set forth in Hemisphere GNSS's relevant User’s Manual and Specifications; (4) damage caused by accident or natural events, such as 

lightning (or other electrical discharge) or fresh/ salt water immersion of Product; (5) damage occurring in transit; (6) normal wear and tear; or (7) the operation or failure of operation 

of any satellite-based positioning system or differential correction service; or the availability or performance of any satellite-based positioning signal or differential correction signal. 

THE PURCHASER IS RESPONSIBLE FOR OPERATING THE VEHICLE SAFELY. The purchaser is solely responsible for the safe operation of the vehicle used in connection with the Product, 

and for maintaining proper system control settings. UNSAFE DRIVING OR SYSTEM CONTROL SETTINGS CAN RESULT IN PROPERTY DAMAGE, INJURY, OR DEATH. 

The purchaser is solely responsible for his/her safety and for the safety of others. The purchaser is solely responsible for maintaining control of the automated steering system at all times. 

THE PURCHASER IS SOLELY RESPONSIBLE FOR ENSURING THE PRODUCT IS PROPERLY AND CORRECTLY INSTALLED, CONFIGURED, INTERFACED, MAINTAINED, STORED, AND OPERATED IN 

ACCORDANCE WITH Hemisphere GNSS's RELEVANT USER’S MANUAL AND 

SPECIFICATIONS. Hemisphere GNSS does not warrant or guarantee the positioning and navigation precision or accuracy obtained when using Products. Products are not intended for 

primary navigation or for use in safety of life applications. The potential accuracy of Products as stated in Hemisphere GNSS literature and/or Product specifications serves to provide 

only an estimate of achievable accuracy based on performance specifications provided by the satellite service operator (i.e. US Department of Defense in the case of GPS) and 

differential correction service provider. Hemisphere GNSS reserves the right to modify Products without any obligation to notify, supply or install any improvements or alterations to 

existing Products. 

 
GOVERNING LAW. This agreement and any disputes relating to, concerning or based upon the Product shall be governed by and interpreted in accordance with the laws of the State 

of Arizona. 

OBTAINING WARRANTY SERVICE. In order to obtain warranty service, the end purchaser must bring the Product to a Hemisphere GNSS approved service center along with the end 

purchaser's proof of purchase. Hemisphere GNSS does not warrant claims asserted after the end of the warranty period. For any questions regarding warranty service or to obtain 

information regarding the location of any of Hemisphere GNSS approved service center, contact Hemisphere GNSS at the following address: 

Hemisphere GNSS 

8515 E. Anderson Drive 

Scottsdale, AZ 85255, USA 

Phone: +1-480-348-6380 

Fax: +1-480-270-5070 

techsupport@hregnss.com     www.hgnss.com 



   

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Hemisphere GNSS Inc. 
8515 East Anderson Drive, Suite A 

Scottsdale, Arizona, US 85255 

 

Phone: 480-348-6380 

Fax: 480-270-5070 

precision@hgnss.com  
www.hgnss.com 



   

 

 

 
 


